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Software Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA 02111-1307 USA.
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that it will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser
General Public License for more details. You should have received a copy of the GNU
Lesser General Public License along with this library; if not, write to the Free Software
Foundation, Inc., 51 Franklin St, Fifth Floor, Boston, MA 02110-1301 USA Permission is
hereby granted to use or copy this program under the terms of the GNU LGPL, provided
that the Copyright, this License, and the Availability of the original version is retained on
all copies.User documentation of any code that uses this code or any modified version of
this code must cite the Copyright, this License, the Availability note, and "Used by
permission." Permission to modify the code and to distribute modified code is granted,
provided the Copyright, this License, and the Availability note are retained, and a notice
that the code was modified is included. AMD Availability:
http://www.cise.ufl.edu/research/sparse/amd

UMFPACK 5.0.2 - UMFPACK Notice: The UMFPACK code was modified. Used by permission.
UMFPACK Copyright: UMFPACK Copyright © 1995-2006 by Timothy A. Davis. All Rights
Reserved. UMFPACK License: Your use or distribution of UMFPACK or any modified version
of UMFPACK implies that you agree to this License. This library is free software; you can
redistribute it and/or modify it under the terms of the GNU Lesser General Public License
as published by the Free Software Foundation; either version 2.1 of the License, or (at
your option) any later version. This library is distributed in the hope that it will be useful,
but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY
or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License for
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more details. You should have received a copy of the GNU Lesser General Public License
along with this library; if not, write to the Free Software Foundation, Inc., 51 Franklin St,
Fifth Floor, Boston, MA 02110-1301 USA Permission is hereby granted to use or copy this
program under the terms of the GNU LGPL, provided that the Copyright, this License, and
the Availability of the original version is retained on all copies. User documentation of any
code that uses this code or any modified version of this code must cite the Copyright, this
License, the Availability note, and "Used by permission." Permission to modify the code
and to distribute modified code is granted, provided the Copyright, this License, and the
Availability note are retained, and a notice that the code was modified is included.
UMFPACK Availability: http://www.cise.ufl.edu/research/sparse/umfpack  UMFPACK
(including versions 2.2.1 and earlier, in FORTRAN) is available at
http://www.cise.ufl.edu/research/sparse . MA38 is available in the Harwell Subroutine
Library. This version of UMFPACK includes a modified form of COLAMD Version 2.0,
originally released on Jan. 31, 2000, also available at
http://www.cise.ufl.edu/research/sparse . COLAMD V2.0 is also incorporated as a built-in
function in MATLAB version 6.1, by The MathWorks, Inc. http://www.mathworks.com .
COLAMD V1.0 appears as a column-preordering in SuperLU (SuperLU is available at
http://www.netlib.org ). UMFPACK v4.0 is a built-in routine in MATLAB 6.5. UMFPACK v4.3
is a built-in routine in MATLAB 7.1.

Qt Version 4.6.3 - Qt Notice: The Qt code was modified. Used by permission. Qt copyright:
Qt Version 4.6.3, Copyright (c) 2010 by Nokia Corporation. All Rights Reserved. Qt
License: Your use or distribution of Qt or any modified version of Qt implies that you agree
to this License. This library is free software; you can redistribute it and/or modify it under
the
terms of the GNU Lesser General Public License as published by the Free Software
Foundation; either version 2.1 of the License, or (at your option) any later version. This
library is distributed in the hope that it will be useful,
but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY
or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License for
more details. You should have received a copy of the GNU Lesser General Public License
along with this library; if not, write to the Free Software Foundation, Inc., 51 Franklin St,
Fifth Floor, Boston, MA 02110-1301 USA Permission is hereby granted to use or copy this
program under the terms of the GNU LGPL, provided that the Copyright, this License, and
the Availability of the original version is retained on all copies.User
documentation of any code that uses this code or any modified version of this code must
cite the Copyright, this License, the Availability note, and "Used by permission."
Permission to modify the code and to distribute modified code is granted, provided the
Copyright, this License, and the Availability note are retained, and a notice that the code
was modified is included. Qt Availability: http://www.qtsoftware.com/downloads  Patches
Applied to Qt can be found in the installation at:
$HPEESOF_DIR/prod/licenses/thirdparty/qt/patches. You may also contact Brian
Buchanan at Agilent Inc. at brian_buchanan@agilent.com for more information.

The HiSIM_HV source code, and all copyrights, trade secrets or other intellectual property
rights in and to the source code, is owned by Hiroshima University and/or STARC.

Errata The ADS product may contain references to "HP" or "HPEESOF" such as in file
names and directory names. The business entity formerly known as "HP EEsof" is now part
of Agilent Technologies and is known as "Agilent EEsof". To avoid broken functionality and
to maintain backward compatibility for our customers, we did not change all the names
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and labels that contain "HP" or "HPEESOF" references.

Warranty The material contained in this document is provided "as is", and is subject to
being changed, without notice, in future editions. Further, to the maximum extent
permitted by applicable law, Agilent disclaims all warranties, either express or implied,
with regard to this documentation and any information contained herein, including but not
limited to the implied warranties of merchantability and fitness for a particular purpose.
Agilent shall not be liable for errors or for incidental or consequential damages in
connection with the furnishing, use, or performance of this document or of any
information contained herein. Should Agilent and the user have a separate written
agreement with warranty terms covering the material in this document that conflict with
these terms, the warranty terms in the separate agreement shall control.

Technology Licenses The hardware and/or software described in this document are
furnished under a license and may be used or copied only in accordance with the terms of
such license. Portions of this product include the SystemC software licensed under Open
Source terms, which are available for download at http://systemc.org/ . This software is
redistributed by Agilent. The Contributors of the SystemC software provide this software
"as is" and offer no warranty of any kind, express or implied, including without limitation
warranties or conditions or title and non-infringement, and implied warranties or
conditions merchantability and fitness for a particular purpose. Contributors shall not be
liable for any damages of any kind including without limitation direct, indirect, special,
incidental and consequential damages, such as lost profits. Any provisions that differ from
this disclaimer are offered by Agilent only.

Restricted Rights Legend U.S. Government Restricted Rights. Software and technical
data rights granted to the federal government include only those rights customarily
provided to end user customers. Agilent provides this customary commercial license in
Software and technical data pursuant to FAR 12.211 (Technical Data) and 12.212
(Computer Software) and, for the Department of Defense, DFARS 252.227-7015
(Technical Data - Commercial Items) and DFARS 227.7202-3 (Rights in Commercial
Computer Software or Computer Software Documentation).
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 Getting Started with Connection
Manager
This section introduces the Connection Manager and explains how to configure the server
IO, access the client's  user interface, connect instruments, and customize and save the
Connection Manager configuration.

 Overview
 Connection Manager is the ADS implementation of Agilent Technologies Connected
Solutions.
Connected Solutions encompasses the integration of ADS software and specific Agilent
instruments (signal generators and signal analyzers) into a solution that enables new
design and verification capabilities. It combines simulation and measurement, and allows
the seamless sharing of signals, measurements, algorithms, and data between the
simulation and measurement domains.

Using Connection Manager, you can:

access and control instruments from ADS dialogs
measure devices and construct ADS datasets from the measurement data
create simulation models based on measured data
use real-time instrument-generated stimulus and measurement during simulations

Connection Manager consists of two parts:

Connection Manager Server

Connection Manager server provides dynamic access and control of remote instruments
and IO diagnostics.

Refer to Connection Manager Server (connectmui) for more information.

Note
One critical customer issue is that certain newer Dell Precision PCs have a problem with their "Bluetooth
Stack for Windows by Toshiba" that conflicts with installing the Connection Manager Server.

When the CM Server is installed on such PCs, the PC will crash and will require a reimage of the PC.
This is a problem inherent with the Toshiba driver.
The work around to use the "Agilent Connection Manager" is to uninstall the "Bluetooth Stack for
Windows by Toshiba".
Although the Bluetooth Stack for Windows by Toshba is uninstalled, XP still provides a Bluetooth
capability.  So, the Bluetooth is still there.

Connection Manager Client

The Connection Manager client provides the interface between ADS and the Connection
Manager server's functionality and extensibility. The client allows the ADS user to
dynamically manage data, configure the server, control input and output, and make
device measurements.
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Refer to Connection Manager Client (connectmui) for more information.

  

 Configuring the Server IO on the PC
Prior to using Connection Manager for the first time, you must configure the IO on the
server workstation.

This section provides instructions for automatically configuring common LAN and GPIB
interfaces, and for manually configuring other interfaces such as LAN/GPIB gateways.
To Configure Common LAN or GPIB Interfaces provides simplified instructions to configure
a common LAN or GPIB interface.

To manually configure an available interface (for example, the Agilent E5810A LAN/GPIB
gateway), see To Manually Configure Other Interfaces.

 

 Using the Agilent IO Libraries Version M versus Agilent IO Libraries
Suite

The Connection Manager supports the latest version of the IO Libraries, the Agilent IO
Libraries Suite . If you have installed the IO Libraries Suite before installing the
Connection Manager server, the server installer will not overwrite that installation with an
old version of the IO Libraries (otherwise, it would install the older version by default).

The CM client window will recognize the new version and display the status information
accordingly. The diagnostics will recognize the new IO Libraries version, although the new
version identifies itself in the registry with an unusual version string.
If the Agilent IO Libraries Suite is not previously installed or the existing installation is
insufficient for the CM's needs, the CM server installation will continue to install the Agilent
IO Libraries Version M (version M.01.01.04).

Note
For systems configured with the ADS 2004A CM server, the server will provide instrument IO using the
new IO Libraries Suite. However, the ADS 2004A CM server window will display a red status in the server's
Required Conditions field due to a change in the Agilent IO Library registry name. Starting with the Agilent
IO Libraries Suite 14 release, the Windows Registry naming structure was changed from previous IO
Libraries version alpha-numeric format (M.01.01.04) to a numeric format (78.0.7202.1), resulting in the
false red status.

 

 To Configure Common LAN or GPIB Interfaces

Follow the instructions in this section to auto-configure the IO and connect instruments to
the server using a LAN or GPIB interface.

 In the server's Windows system tray, select IO > Run IO Config .1.
This opens the IO Config dialog. The Available Interface Types group box lists the IO
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types supported by the Agilent IO Libraries. List entries with and asterisk ( * ) can be
automatically configured in step 2.
 To automatically configure common LAN and GPIB interfaces in the IO Config dialog,2.
select Auto Config .
Auto-configured interfaces appear in the Configured Interfaces group box, as shown.

 

 If you encounter a problem

 For GPIB interfaces, ensure that the GPIB interface is installed/connected to the server.
For LAN interfaces, the IO auto-configuration routine creates a TCPIP network tunnel and
displays TCPIP lan in the Configured Interfaces group box. The routine creates only one
TCPIP interface regardless of how many LAN cards are installed on the server workstation.
Follow the steps in To Connect Instruments to the Server through the LAN to complete the
LAN interface configuration.

 

 To Connect Instruments to the Server through the LAN

Unlike GPIB interfaces where instruments communicate directly with the server via an
exclusive bus, the Agilent IO libraries do not dynamically discover instruments connected
to the server via LAN. You must manually add LAN devices to the server IO.

To add LAN devices, complete the following steps.
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 In the IO Config dialog, highlight TCPIP0 in the Configured Interface group box and1.
click Edit .
In the LAN Client dialog, click Edit VISA Config .2.
In the TCPIP devices dialog, click Add device .3.
In the Add a TCPIP device dialog Machine Name/IP field, enter the IP address of4.
the instrument you would like to connect to the server and click OK .

In the TCPIP devices dialog, click OK .5.
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In the LAN Client dialog, click OK .6.
In the IO Config dialog, click OK .7.

 

 If you encounter a problem

 Ensure the following conditions are met:

The server is connected to the LAN.
The instrument is connected to the LAN.
The instrument line power is switched on.
The LAN is operational.

To start the Connection Manager client, see Accessing the Client From a Schematic Page.

 

 To Manually Configure Other Interfaces

This section explains how to manually configure an IO that cannot be auto-configured by
the Agilent IO Library. This section explains how to configure a LAN/GPIB gateway, such
as the Agilent E5810A. Follow the screen prompts to manually configure your installed
interface.

 Follow the instructions in this section to manually configure a LAN/GPIB gateway.

 In the Windows system tray, select IO > Run IO Config .1.
In the Available Interface Types group box, highlight VISA LAN Client Interface2.
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(E5810A) and click Configure .
In the VISA LAN Client Interface (LAN to GPIB) dialog Local Settings group box, use3.
the scroll box to choose a VISA Interface Name.
In the Remote Settings group box, enter the hostname or IP address of the LAN/GPIB4.
gateway.
In the Remote Settings group box, enter the SICL interface name assigned to the5.
LAN/GPIB gateway (or other network interface device) and click OK .
During the process of configuring the LAN/GPIB gateway, you must assign a SICL
interface name to the device. You must enter the same SICL interface name in the
Remote SICL Interface Name data entry field.

In the VISA LAN Client Interface (LAN to GPIB) dialog, click OK .6.
 To exit the IO configuration without connecting instruments to the server, in the IO
Config dialog click OK . To connect instruments to the server, follow the steps in To
Connect Instruments to the Server through the LAN.

To start the Connection Manager client, see Accessing the Client From a Schematic Page.

 

 If you encounter a problem

Ensure the following conditions are met:

The server is connected to the LAN.
The LAN is operational.
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 Accessing the Client From a Schematic Page
 From the ADS Main window open or create an ADS workspace.1.
From an ADS Schematic window, select Tools > Connection Manager Client ... .2.
This opens the Connection Manager Client main window. When the client starts, the
Getting Started dialog is displayed, as shown.

To dismiss the Getting Started dialog, click OK .3.
Selecting the Don't show this dialog box again checkbox prevents this dialog from
appearing again.

 

 Selecting a Server Workstation and Connection Port
The Connection Manager client requires TCP/IP network connectivity to a computer
running the Connection Manager server.
To specify a machine as the Connection Manager server, follow these steps.

 From the Connection Manager Client main window, select Server > Set Server... .1.
This opens the Set Server dialog. Use this dialog to connect the client to a specific
port on a specific server for the remainder of the client session. Values entered in the
Server Host Configuration group box specify the workstation running the Connection
Manager server.
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 Enter an IP address or a DNS (host) name in the upper data entry field and click OK2.
.
An IP address takes the form of a series of period-separated numeric entries
representing a workstation, such as 162.156.24.58 .

Hint
 You can find the IP address of a Windows workstation by typing the command ipconfig -all into a
command line window.

You can also specify the server using either the short form or fully qualified DNS
(Domain Name Server) host name. If the client and server workstations have been
configured to do so, you can use the short form of DNS name. For example you may
wish to use myserver , the short form of the fully qualified DNS name
myserver.mycompany.com .

Note
You can find the server workstation host name
by typing the command hostname into a command window.

For clients on PC platforms, the default server entry is localhost (specifying the client
and server on the same PC workstation). On other platforms, the Server IP Address
or DNS Name entry field is undefined by default.

The default port is 4790. For information on how to change the port number refer to
Connection Manager Server (connectmui).

 

 Discovering Connected Hardware   
All instruments must connect to or through the server workstation. The Remote
Instrument Explorer dialog provides information about the server workstation.
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For PC-based systems, the Connection Manager client and server commonly reside on the
same physical machine. Because of this, instrument configuration may take place on the
same workstation that the client resides.

Note
If you have not already done so, follow the steps in To Configure Common LAN or GPIB Interfaces to
configure your Agilent IO Libraries.

 To access the Remote Instrument Explorer dialog from the Connection Manager1.
Client window, select Instruments > Remote Instrument Explorer... .
Enter the DNS host name or IP address of the workstation on which the Connection2.
Manager server is running.
If the default port number is not being used, enter the port number on which the3.
server listens for incoming requests.

Note
By default the port number is 4790. For information on changing the port refer to Understanding IO
Configuration (connectmui).

Select OK to access the Remote Instrument Explorer dialog.4.

This dialog box shows the VISA (Virtual Instrument Software Architecture) Resource
identifiers of all instruments that are currently connected to the workstation running the
Connection Manager server. A VISA Resource identifier can uniquely identify an
instrument among all the instruments connected to the workstation through all available
interfaces.
 To map the VISA Resource identifiers to the associated instrument model number, click
Query All Instruments' IDs .

This instructs the Connection Manager server to send *IDN? (the IEEE 488.2 standard
command for instrument identification) to all instruments on the bus.
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Note
Some older instruments cannot respond to *IDN? and show an error, usually a time out, in the Instrument
ID field.

Five instruments (and one printer pass-through at address 15) have been discovered on
the GPIB0 interface.

Note
Though the VISA Resource column lists the instruments resource identifier syntax, it is not necessary to
remember these VISA identifiers. The measurements that use these instrument resource identifiers
display them in a drop-down list within the measurement panels.

To repopulate the list after adding or removing instruments from the server, click Refresh
.
  

 Customizing Instrument Identification Strings
 
File-based instrument discovery allows you to apply your own identification string to
instruments displayed in the Remote Instrument Explorer dialog. This IO configuration file
can be configured on either the client workstation (IOConfig.iml) or the server workstation
(IOConfig.xml).
The Connection Manager server will attempt to populate the Instrument Explorer in the
following order:

With the contents of the $HOME/hpeesof/Config/IOConfig.iml (the client-based1.
configuration file)
With the contents of the <CM server installation directory>/IOConfig.xml (the server-2.
based configuration file)
With dynamically discovered instruments connected to the server.3.
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 Client-Based IO Configuration

Instead of the server querying the IO for connected instruments or the contents of a
server-side user-defined XML file, the server queries a file on the client workstation and
displays the results in the Remote Instrument Explorer dialog.

The VISA libraries do not have the capability to dynamically discover instruments through
the TCPIP entry in the IO Libraries IO Configuration database. Using file-based instrument
discovery allows the Remote Instrument Explorer dialog to list network-connected
instruments that would otherwise not appear.

This configuration is useful for installations where many clients are connected to a single
server. Using a client-side configuration allows for a smaller list of selectable instruments
than are physically present on the server, making it possible to tailor the Instrument
Explorer to display on the instruments of interest to a particular user.

Note
When using file-based instrument discovery, no instrument communication takes place during the
discovery process.

This procedure modifies and then references the IOConfig.iml file on the client computer
for instrument discovery.

In the Connection Manager Client main window, choose Instruments > Remote1.
Instrument Explorer .
In the Remote Instrument Explorer dialog, click Query All Instrument ID's , as2.
shown.

In the Connection Manager Client main window, choose File > Save As .3.
For UNIX and Linux systems , browse to the ADS configuration directory (by default4.
$HOME/hpeesof/config/ ), enter the file name IOConfig.iml (case sensitive), and click
Save .
For PC systems_ , in the Save As dialog, use the Look in: drop-down box to navigate
the to ADS configuration directory (by default C:\users\default\hpeesof\config ),
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enter IOConfig.iml (case sensitive).
In a text editor on the client workstation, open the IOConfig.iml file, as shown.5.
<MsmtClientConfig Version="1.0" RemoteHost="localhost" Port="4790"
ServerSelected="0">
<InstExplorer RemoteHost="localhost" Port="4790">
<IOConfigEntries>
<IOConfigEntry VisaResource="GPIB0::14::INSTR" InstrumentDescription="Agilent
Technologies,8753E,0,7.14" />
<IOConfigEntry VisaResource="GPIB0::15::INSTR"
InstrumentDescription="VI_ERROR_TMO: A
timeout occurred" />
<IOConfigEntry VisaResource="GPIB0::16::INSTR" InstrumentDescription="Agilent
Technologies,E8358A,US40210024,A.04.25" />
<IOConfigEntry VisaResource="GPIB0::18::INSTR" InstrumentDescription="Agilent
Technologies,E4406A,US41152605,A.04.21 20000921 10:42:11" />
<IOConfigEntry VisaResource="GPIB0::19::INSTR" InstrumentDescription="Agilent
Technologies,
ESG-D4000B, MY41000133, B.03.75" />
<IOConfigEntry VisaResource="GPIB0::7::INSTR" InstrumentDescription="Agilent
Technologies,54832D,MY42000431,I.02.25 R,080" />
</IOConfigEntries>
</InstExplorer>
<Measurements />
</MsmtClientConfig>
Add additional bolded sections, as shown, for every server you want to search for6.
instruments. <MsmtClientConfig Version="1.0" RemoteHost="localhost" Port="4790"
ServerSelected="0">
<InstExplorer RemoteHost="localhost" Port="4790">
<IOConfigEntries>
<IOConfigEntry VisaResource="GPIB0::14::INSTR" InstrumentDescription="Agilent
Technologies,8753E,0,7.14" />
<IOConfigEntry VisaResource="GPIB0::15::INSTR"
InstrumentDescription="VI_ERROR_TMO: A
timeout occurred" />
<IOConfigEntry VisaResource="GPIB0::16::INSTR" InstrumentDescription="Agilent
Technologies,E8358A,US40210024,A.04.25" />
<IOConfigEntry VisaResource="GPIB0::18::INSTR" InstrumentDescription="Agilent
Technologies,E4406A,US41152605,A.04.21 20000921 10:42:11" />
<IOConfigEntry VisaResource="GPIB0::19::INSTR" InstrumentDescription="Agilent
Technologies,
ESG-D4000B, MY41000133, B.03.75" />
<IOConfigEntry VisaResource="GPIB0::7::INSTR" InstrumentDescription="Agilent
Technologies,54832D,MY42000431,I.02.25 R,080" />
</IOConfigEntries>
</InstExplorer>
<InstExplorer RemoteHost="sanc070322977.soco.agilent.com"
Port="4790">
<IOConfigEntries>
<IOConfigEntry VisaResource="GPIB1::16::INSTR" />
</IOConfigEntries>
</InstExplorer>
<InstExplorer RemoteHost="123.456.789.10" Port="4790">
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<IOConfigEntries>
<IOConfigEntry VisaResource="GPIB2::7::INSTR"
InstrumentDescription="My Scope" />
</IOConfigEntries>
</InstExplorer>
<Measurements />
</MsmtClientConfig>
For each server (in this example, sanc070322977.soco.agilent.com and
123.456.789.10 ) connected to instrument you wish to list, there is an InstExplorer
attribute, contained in the <InstExplorer> </InstExplorer> tags.
The RemoteHost attribute describes the server to which the instruments are
connected.
The IOConfigEntries tag surrounds the list of instruments you want to list for the
associated server. Each IOConfigEntry entry lists the information for one instrument.
The VisaResource attribute is the string that will be used to identify the instrument to
the IO Libraries.
The InstrumentDescription attribute populates the Instrument ID field in the
Instrument Explorer. If you do not include an InstrumentDescription attribute, the
Instrument Explorer will display the string No corresponding instrument
description in IO configuration file in the Instrument ID field.
Change the InstrumentDescription attributes to customize the instrument7.
identification, as shown. <IOConfigEntries>
<IOConfigEntry VisaResource="GPIB0::14::INSTR" InstrumentDescription="NWA on
my bench" />
<IOConfigEntry VisaResource="GPIB0::15::INSTR" InstrumentDescription="NWA
printer
pass-through" />
<IOConfigEntry VisaResource="GPIB0::16::INSTR" InstrumentDescription="Agilent
E8358A in the
lab" />
<IOConfigEntry VisaResource="GPIB0::18::INSTR" InstrumentDescription="VSA on
my bench" />
<IOConfigEntry VisaResource="GPIB0::19::INSTR" InstrumentDescription="PSG on
my bench" />
<IOConfigEntry VisaResource="GPIB0::7::INSTR" InstrumentDescription="Infiniium
on my bench" />
</IOConfigEntries>
To list network-connected instruments, create the following IOConfigEntry, where8.
TCPIP0 is the configured network IO, server1.mycompany is the DNS name of the
remote server to which the hardware is connected, and PSG in Japan is the
customized instrument identifier, as shown.

<IOConfigEntry VisaResource="TCPIP0::server1.mycompany.com::INSTR"
InstrumentDescription="PSG in Japan" />

Save the IML file to the ADS configuration directory (by default9.
$HOME/hpeesof/config/ ).
To display your customized instrument identifiers, in the Remote Instrument Explorer10.
dialog, click Refresh > Query All Instrument ID's , as shown.



Advanced Design System 2011.01 - Connection Manager

20

 

 Server-Based IO Configuration

Instead of the server querying the IO for connected instruments, the server displays the
contents of a user-defined XML file in the Remote Instrument Explorer dialog.

The VISA libraries do not have the capability to dynamically discover instruments through
the TCPIP entry in the IO Libraries IO Configuration database. Using file-based instrument
discovery allows the Remote Instrument Explorer dialog to list network-connected
instruments that would otherwise not appear.

Note
When using file-based instrument discovery, no instrument communication takes place during the
discovery process.

This procedure modifies and then references the IOConfig.xml file on the server PC for
instrument discovery.

In the Connection Manager Client main window, choose Instruments > Remote1.
Instrument Explorer .
In the Remote Instrument Explorer dialog, click Query All Instrument ID's , as2.
shown.
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In the Connection Manager Client main window, choose File > Save As .3.
For UNIX and Linux systems , enter the file name IOConfig.xml (case sensitive), note4.
the directory to which the file is being saved, and click Save .
Next, from the server PC transfer this file from the UNIX or Linux directory to the
Connection Manager installation directory on the server PC. This directory is
C:\Program Files\Agilent\Connection Manager Server by default.
For PC systems_ , in the _Save As dialog, use the Look in: drop-down box to
navigate the to CM server installation directory.
This directory is C:\Program Files\Agilent\Connection Manager Server\ by default.
In the Save As dialog File name: entry box, enter IOConfig.xml (case sensitive).
In the Save As dialog File type: drop-down box, choose Connection Manager
Client Serialization Files (.xml)* and click OK .
In a text editor on the server PC, open the IOConfig.xml file, as shown.5.
<MsmtClientConfig Version="1.0" RemoteHost="localhost" Port="4790"
ServerSelected="0">
<InstExplorer RemoteHost="localhost" Port="4790">
<IOConfigEntries>
<IOConfigEntry VisaResource="GPIB0::14::INSTR" InstrumentDescription="Agilent
Technologies,8753E,0,7.14" />
<IOConfigEntry VisaResource="GPIB0::15::INSTR"
InstrumentDescription="VI_ERROR_TMO: A
timeout occurred" />
<IOConfigEntry VisaResource="GPIB0::16::INSTR" InstrumentDescription="Agilent
Technologies,E8358A,US40210024,A.04.25" />
<IOConfigEntry VisaResource="GPIB0::18::INSTR" InstrumentDescription="Agilent
Technologies,E4406A,US41152605,A.04.21 20000921 10:42:11" />
<IOConfigEntry VisaResource="GPIB0::19::INSTR" InstrumentDescription="Agilent
Technologies,
ESG-D4000B, MY41000133, B.03.75" />
<IOConfigEntry VisaResource="GPIB0::7::INSTR" InstrumentDescription="Agilent
Technologies,54832D,MY42000431,I.02.25 R,080" />
</IOConfigEntries>
</InstExplorer>
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<Measurements />
</MsmtClientConfig>
Remove all but the <IOConfigEntries> section, as shown. <IOConfigEntries>6.
<IOConfigEntry VisaResource="GPIB0::14::INSTR" InstrumentDescription="Agilent
Technologies,8753E,0,7.14" />
<IOConfigEntry VisaResource="GPIB0::15::INSTR"
InstrumentDescription="VI_ERROR_TMO: A
timeout occurred" />
<IOConfigEntry VisaResource="GPIB0::16::INSTR" InstrumentDescription="Agilent
Technologies,E8358A,US40210024,A.04.25" />
<IOConfigEntry VisaResource="GPIB0::18::INSTR" InstrumentDescription="Agilent
Technologies,E4406A,US41152605,A.04.21 20000921 10:42:11" />
<IOConfigEntry VisaResource="GPIB0::19::INSTR" InstrumentDescription="Agilent
Technologies,
ESG-D4000B, MY41000133, B.03.75" />
<IOConfigEntry VisaResource="GPIB0::7::INSTR" InstrumentDescription="Agilent
Technologies,54832D,MY42000431,I.02.25 R,080" />
</IOConfigEntries>
Change the InstrumentDescription attributes to customize the instrument7.
identification, as shown. <IOConfigEntries>
<IOConfigEntry VisaResource="GPIB0::14::INSTR" InstrumentDescription="NWA on
my bench" />
<IOConfigEntry VisaResource="GPIB0::15::INSTR" InstrumentDescription="NWA
printer
pass-through" />
<IOConfigEntry VisaResource="GPIB0::16::INSTR" InstrumentDescription="Agilent
E8358A in the
lab" />
<IOConfigEntry VisaResource="GPIB0::18::INSTR" InstrumentDescription="VSA on
my bench" />
<IOConfigEntry VisaResource="GPIB0::19::INSTR" InstrumentDescription="PSG on
my bench" />
<IOConfigEntry VisaResource="GPIB0::7::INSTR" InstrumentDescription="Infiniium
on my bench" />
</IOConfigEntries>
To list network-connected instruments, create the following IOConfigEntry, where8.
TCPIP0 is the configured network IO, server1.mycompany is the DNS name of the
remote server to which the hardware is connected, and ESG in Japan is the
customized instrument identifier, as shown.

<IOConfigEntry VisaResource="TCPIP0::server1.mycompany.com::INSTR"
InstrumentDescription="PSG in Japan" />

Save the XML file to the CM server installation directory (by default: C:\Program9.
Files\Agilent\Connection Manager Server\ ).
To display your customized instrument identifiers, in the Remote Instrument Explorer10.
dialog, click Refresh > Query All Instrument ID's , as shown.
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 Saving the Application State
Connection Manager tracks the current state of configuration and saves this information to
an application state file. A application state file contains the current client configuration.
The status area of the client main window updates to indicate whether the application
state has changed and if an application state file has been associated with a given session.

If a content change to the client window occurs before a state file is defined by a file save
operation, an asterisk appears in the status bar.

In the client dialog, click File > Save as ... .1.
Save the application to a file named state1 .2.
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After saving the session state, the status bar records the location of the state file.

Further changes to the client session append an asterisk to the state file name.

For more information, see File Menu (connectmui).
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 Operational and Functional Concepts
This section offers detailed information on the operational theory of the Connection
Manager, including client-server architecture, server operational modes, removal, and
installation, and detailed explanations of the measurement dialogs.

  

 Client-Server Architecture
 In its basic form, the client/server is a computational architecture involving a client
process requesting a service from a server process.

Client-server architecture is referred to as a logical extension of modular programming,
which recognizes that software can be broken into its constituent parts for manageability
purposes. With client-server architecture this is carried a step further by acknowledging
that the modules do not need to execute within the same memory space. This enables the
client and the server to run on the hardware and software programs best suited for their
individual functions.

In the case of Connection Manager, this allows the server to utilize a wide variety of
instrument-control capabilities only available on the Windows platform, while the client
can be accessed from any platform that supports ADS.

 

 Functional Process

In this architecture, the client sends a message to the server, requesting that the server
perform a task. The client provides the user-interface portion of the application, validates
data entered by the user, sends requests to the server programs and can execute
business logic.

The server program receives requests from the client, manages the interaction between
the client and any connected instrumentation, retrieves and updates information,
manages data integrity and dispatches responses to client requests.

The Connection Manager Client operates in conjunction with an ADS workspace. The
datasets and other files generated from measurements reference the ADS workspace and
workspace data directories.

The client caches the discovery dialog contents. For example, start the Remote Instrument
Explorer and point it at a specific workstation (for example, myserver ), then select the
close icon in the title bar to dismiss it. The next time the Remote Instrument Explorer is
opened and pointed at myserver, the client recalls the last information stored on the
Connection Manager client about myserver's contents. This prevents a potentially time-
consuming conversation between the client and server every time a discovery dialog is
opened.
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Note
To get the latest view of the server configuration, on the measurement panel click Refresh.

 

 Data Interface

For a client to communicate with the server, they must agree on a common endpoint for
the communication. That common end point is a network port number. The port number is
a unique number the server uses to allow Connection Manager client connections to
particular services. By default, the server accepts client requests on port 4790. 

The port number is defined within the MsmtSrvr.exe.config file located in the server
installation directory, by default, C: \ Program Files \ Agilent\Connection Manager Server \
MsmtSrvr.exe.config.

The contents of the default configuration file are:

<configuration>

<appSettings>

<add key="port" value="4790"/>

</appSettings>

</configuration>

To change the default port number, see Changing the Default Server Port Number.

 

 Connection Manager Server
 The Connection Manager (CM) Server is one half the Connection Manager client/server
environment. By default, the CM server runs as an Windows program. To run the server
as a Windows service , see Running the Server as a Windows Service.

Because the server uses Windows-based supporting applications, it requires installation on
a PC running a version of Microsoft Windows 2000 Professional or Windows XP
Professional (or one of its successors).

 The Connection Manager Server consists of two cooperating processes: CMController.exe
and MsmtSrvr.exe. These processes work together to create the Windows program user
interface, provide instrument connectivity, and to manage application behavior.

 

 The CMContoller.exe Process

CMController.exe is the main server process. It allows the CM server to run as a Windows
program. CMController.exe produces the server user interface, the Agilent Connection
Manager Server dialog and controls the lifetime of the MsmtSrvr.exe process.

During installation, the Windows executable that produces the Agilent Connection Manager
Server dialog is placed into the Windows system startup group. The server starts
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automatically whenever you log on to the server PC.

When the Connection Manager server starts, the process examines the server PC
configuration and displays the results in the Agilent Connection Manager Server dialog.

The process first checks to ensure the required support products are correctly installed
and properly configured, then displays the results in the Required Conditions group box. If
a component is missing or incorrectly configured, the dialog displays the problem
condition in red.

Next, the process checks for installed instrument drivers and displays the results in the
Optional Components group box. A check appears in the box in front of an installed driver.
Instrument drivers are needed only for specific measurements, so in some cases,
unnecessary drivers are not installed.

The Agilent Connection Manager Server dialog provides menu access to selections that
control server functionality. These menus (File, Control, Diagnostics, and Help) provide
access to server shutdown, restart, configuration diagnosis, and documentation,
respectively.

The diagnostics function collects data on the installation and configuration of supporting
applications, interface configuration, and account information. After diagnostics are run,
the results are saved as a file that can be delivered to Agilent support engineers to aid in
troubleshooting connectivity problems.

 

 The MsmtSrvr.exe Process

The MsmtSrvr.exe is a Microsoft .NET application that uses a networked interface
capability called remoting. Remoting is the ability for a Microsoft .NET component to
appear as if it is running locally in a client, when it is actually running remotely in another
process.

 

 Understanding IO Configuration

The Connection Manager's server uses the Agilent IO Libraries to achieve instrument
communication. For the IO Libraries to communicate with the instrument interfaces, there
must be one or more background processes (referred to as daemons) running on the
server PC.

The IO Libraries installation usually puts a shortcut to this daemon in the system startup
group of the Windows shell. This shortcut starts the IO Libraries daemon when you log
onto the server PC.

If a user tries to log into the server PC while the server is running in the background, the
system startup group tries to start the IO Libraries daemons a second time, which brings
up the following dialog:
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Note
When this dialog presents itself, click No. Otherwise, there will be two IO control applications running.

 

 Viewing Installed IO Libraries

To view which version of the IO Libraries you have installed, complete the following steps.

In the server's Windows system tray, select IO > View Documentation >1.
Installation and Path Information.
Observe the Agilent IO Libraries Installation and Path Information dialog.2.

 

 Supported Instrument IO Interfaces

The supported Agilent IO interface hardware matrix can be found at:
http://www.home.agilent.com/upload/cmc_upload/All/Interface_Support_Matrix.pdf

Information on configuring the Agilent IO Libraries is available from:
http://www.agilent.com/find/iolib

Select the IO Libraries Installation and Configuration Guide for Windows link and
go to Configuring IO Interfaces. This section has detailed configuration steps for the
supported IO interfaces.

 

http://www.home.agilent.com/upload/cmc_upload/All/Interface_Support_Matrix.pdf
http://www.home.agilent.com/upload/cmc_upload/All/Interface_Support_Matrix.pdf
http://www.agilent.com/find/iolib
http://www.agilent.com/find/iolib
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 Additional Resources

For more detailed information on IO configuration, refer to the documentation for the  IO
libraries.

To view the documentation, in the Windows task bar, select IO > View Documentation.

 

 Changing the Server Default Port Number from the Server

 To change the server port, change the number in the value field of the port configuration
key.

For example, to modify the server to listen on port 5885, modify the value in
MsmtSrvr.exe.config :
<add key="port" value="5885"/>

You must restart the server to initiate the port number change. To restart the server, in
the Agilent Connection Manager Server dialog, click Control > Restart Server.

Note
You can view the currently active ports on the server by typing the command netstat -a into a command
line window. This yields a list of bound ports including the Connection Manager server ports:

TCP       dudetop:4790       0.0.0.0:0           LISTENING

TCP       dudetop:4791       0.0.0.0:0           LISTENING

 

 Overriding Windows Power Management Functionality

Windows 2000 and later versions of the Windows operating system include a power
management facility that turns off the display and puts the PC into a low-power state after
extended periods without activity.

The Connection Manager server is intended to operate for long periods of time
unattended. The IO Libraries cannot perform instrument communications once a PC has
transitioned to a low-power state. Therefore, at startup, the server issues a command
preventing the operating system from transitioning to low-power states while allowing the
monitor to turn itself off.

Once the server's main thread has finished running, it issues another command enabling
the operating system to again transition to a standby or hibernate state.

 

 Running the Server as a Windows Service

In ADS 2004A, the Connection Manager server runs as a Windows application. If
preferred, the server can run as a Windows service, as in earlier implementations.
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Note
The Windows service cannot be configured into the Windows system, as both the Windows service and the
Windows application cannot control the MsmtSrvr.exe lifetime.

To configure the server to run as a service, complete the following steps.

Open a Windows session running under an account that has Administrator privileges.1.
Right click on the Windows Start button, then select Explore All Users.2.
Select the Programs icon, then the Startup icon.3.
Right click the Agilent Connection Manager Server icon and select Properties.4.
The CM server installation directory in listed in the Target field in the Properties
dialog. Record the directory where the CM server is installed.
Remove the Agilent Connection Manager short cut from the Windows System Startup5.
program group.
From a command prompt, change directories to the directory you recorded above.6.
Run the command MsmtSrvc -install.7.
Run the command MsmtSrvc -start.8.
 The process owner is listed as AUTHORITY\SYSTEM. The System account in Windows
is a privileged account, similar to the Super User account in UNIX. Many Windows
services are configured to run under the security context of this account.

You can configure the environment under which the Windows Service runs to restrict its
access privileges to those of a particular login account. You can configure the service to
start when the server workstation boots or require someone to specifically start it. To
configure a Windows Service select Administrative Tools > Services from the Windows
Control Panel.

In the preceding illustration, the Startup Type is set to Manual. In this mode, the service
requires someone to specifically start this service. When the type is set to Automatic, the
service starts whenever the workstation is booted. Once a service is started, it remains
running until specifically stopped. This allows a service to run and perform whatever
activity it is responsible for, independent of whether other users log onto or off of the
server workstation.

Note
By default, this service starts automatically.
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The security environment is set in the Log On section of the Properties dialog in Windows
2000. To open this dialog:

Select a process (i.e., Connection Manager).1.
Choose Action > Properties from the Services toolbar.2.
Choose the Log On tab at the top of the dialog.3.
This section determines what security environment a service (and any processes it
spawns) uses while running. The System account, as previously stated, is privileged.

The selection labeled This account runs the service under the account privileges of a
distinguished principle (e.g., some login account other than System). When
configured this way, the server inherits the named account's access privileges.
Services running under the account privileges of a distinguished principle cannot
open windows on the interactive desktop.

 When the service is running, error and informational messages are reported using the
Windows Event Log. To use the Event Viewer application, on Windows 2000 task bar,
select Start > Settings > Control Panel > Administrative Tools > Event Viewer.

To view the Connection Manager event log entries, switch the Event Viewer to its
Application mode and search for entries with the Source category of
AgilentConnectionManager.
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 Configuring User Account Privileges on the PC

Many IT departments restrict the privileges on Local System accounts, thereby disabling
Connection Manager Server instrument communications. We strongly recommend that you
do not use the Local System account to run the Connection Manager server. Rather, the
server should run under the account of a distinguished principal (i.e., a login account
other than Local System).

In addition, the supporting application Agilent VISA COM libraries require Administrator
privileges on the user account. To ensure that this condition exists, we recommend that
you change the account under which the Connection Manger Server runs.

Note
The following example illustrates the procedure for a Windows 20000 operating system. Windows XP has
similar procedures for controlling the environment under which a service runs. The Services Control Panel
application is the starting point on all Windows operating systems.

To change the account information on Windows 2000:

From the Windows 2000 toolbar, select Start > Settings > Control Panel.1.
From the Control Panel dialog, select Administrative Tools > Services.2.
Highlight Agilent Connection Manager, then click the Properties toolbar button.3.
From the Log On tab, select the This account: radio button from the Log on as:4.
group.
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Change the account name from LocalSystem to an account that has Administrator5.
privileges. To do this, either enter an account name, or select the name from a list by
clicking the Browse... button.

Note
You can select an account that is local to the PC running the CM server, or an account in your
company's domain. If choosing an account in your domain, that domain account must be in the local
Administrators group on the PC running the CM server.

To ensure that a domain account has Administrator privileges on the machine6.
running the CM server, open the Control Panel's Users and Passwords application.
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Select the domain account from the Users tab, choose Properties.7.
From the Properties dialog select the Group Membership tab, choose Other:.8.
Select Administrators from the drop-down list control. Click OK.9.

Type in the account password in your Service Properties dialog. Click OK.10.
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Click Restart Service in the toolbar on the Services control panel for the new11.
settings to take effect.

  

 Changing the Default Server Port Number

If you are running the server as a Windows service, to have the server recognize this new
value, select Agilent Connection Manager in the Services dialog, then choose Action to
stop and restart the Windows Service as shown.

A Windows Service sets the security environment and controls the process lifetime of the
other server components. The highlighted entry is the Windows Service. The subordinate
process is the actual Connection Manager Server (MsmtSrvr.exe), as shown.
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Note
The  Process Explorer tool is available at: http://www.sysinternals.com/  

  

 Removing the Server from the PC

There are two methods for removing Connection Manager server from a PC workstation.
The easiest method uses the installation disc to remove the server and all other related
support programs.

The other method uses Windows Add/Remove Programs dialog to remove each individual
component.

 

 To remove the server using the server installation disc

When the Connection Manager Server InstallShield dialog appears, choose the1.
Remove radio button and click Next.
When the program removal confirmation dialog appears, click Yes.2.
When the Connection Manager Server InstallShield dialog appears, click Finish.3.
When the Connection Manager Server InstallShield dialog appears, select the Yes I4.
want to restart my computer now radio button and click Finish.

Removing the server using the installation disc does not remove any of the supporting
applications. These supporting applications are considered shared system components
that other applications may depend upon. To remove the supporting applications, use the
Windows Control Panel Add/Remove Programs application to remove the shared
components.

Remove these shared components in the following order:

856x Plug & Play Driver1.
859x Plug & Play Driver2.
871x Plug & Play Driver3.
875x Plug & Play Driver4.
E4406 Plug & Play Driver5.
E444x Plug & Play Driver6.
ESG Plug & Play Driver7.

http://www.sysinternals.com/
http://www.sysinternals.com/
http://www.sysinternals.com/
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AgilentRfSigGen IVI-COM Driver8.
Agilent T&M Programmers Toolkit Redistributable Package 1.19.
Agilent IO Libraries, which removes VISA COM10.
Microsoft .NET Framework 1.111.

 

 To remove the server using Windows Add/Remove Programs dialog

 From the Windows task bar, select Start > Settings > Control Panel >1.
Add/Remove Programs.
Select the Agilent IO Libraries and click Change/Remove. Follow the command2.
prompts to remove the Agilent IO Libraries.
Select the Agilent T&M Programmers Toolkit Redistributable Package and click3.
Change/Remove. Follow the command prompts to remove the Agilent T&M
Programmers Toolkit Redistributable Package.
Select each individual Plug&Play driver and click Change/Remove. Follow the4.
command prompts to remove each individual Plug&Play driver.
Select Agilent VisaCom and click Change/Remove. Follow the command prompts5.
to remove Agilent VISA COM.
Select Connection Manager Server and click Change/Remove. Follow the6.
command prompts to remove Connection Manager Server.
Select Microsoft .NET Framework and click Change/Remove. Follow the7.
command prompts to remove Microsoft .NET Framework.

 

 Reinstalling the Server on a PC

Connection Manager server can be installed and used with and Advanced Design System
(ADS). Follow these instructions to install the Connection Manager server and configure
the server IO.

 

 Before You Begin

To communicate with instruments, you must install the Connection Manager server.
Before installing the server, ensure that your PC workstation and your EDA software
licensing meet the following requirements.

  

 System Requirements

The server must be installed on a Windows PC connected to the same network as the EDA
software network server or local installation.

Note
Connection Manager Server cannot be installed on 64-bit machines.
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Requirement Description

 Processor Pentium III 450 MHz or higher

 RAM 256 MB

Hard Disk Space 500 MB on system drive

Operating System Windows 2000 Professional (Service Pack 2)
Windows XP Professional (Service Pack 1)

Network Configuration TCP/IP

Supported
Media Type

CD-ROM required for program installation.

  

 Licensing Requirements

Although the Connection Manager client requires a license, Connection Manager server
does not require a license regardless of where it is installed.

Note
The Connection Manager client is installed during the main software installation. The link_connect_mgr
license is required to run the client from a schematic page. Connection Manager client and server
installations are not related to the client-server installation of the EDA software .

  

 EDA Software Version Requirements

The Connection Manager client and server software must be from the same release.

If you used an older release of Connection Manager, install latest version of Connection
Manager server when you install latest version of the EDA software.

  

 Installation Package Overview

The Connection Manager server installation installs all the software necessary to enable
the EDA software-supplied measurements. This includes:

Run-time versions of the Agilent Test and Measurement Programmer's Toolkit. This
includes the most recent version of VISACom available when the Toolkit was
released. The latest version is available from the Agilent Developer Network at:
http://adn.tm.agilent.com
The Agilent IO Libraries
ADS Measurement Libraries
Plug&Play and IVI-COM drivers
Run-time versions of Microsoft .NET, suitable for running .NET application
The Connection Manager server

 

 Installation Types

http://adn.tm.agilent.com
http://adn.tm.agilent.com
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 Complete

The Complete installation installs all program features in the default installation directory
C:\Program Files\Agilent\Connection Manager Server.

 

 Custom

The Custom installation lets you define the installation directory and choose the optional
program features, such as the ADS Measurement Library, Connection Manager
documentation, Ptolemy VEE Link Server, and VEE Service Control Panel Application.

  

 Installing the Server

Ensure that your PC workstation meets the system requirements.1.
Insert the Connection Manager Server 2004A Installation Disc into the workstation2.
CD-ROM drive.
When the installation wizard prompts you, choose the type of installation.3.
Follow the command prompts to complete the installation.4.

 

 For Windows XP Service Pack 2 Systems Only

When the system reboots, Connection Manager Server starts and the Windows1.
Security Alert dialog appears.

In the Windows Security Alert dialog, click Unblock.2.

This creates an exception in the Windows Firewall that allows network connections through
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the firewall to the Connection Manager server.

This completes the installation process. To connect instruments to the server workstation,
complete the steps in Configuring the Server IO on the PC (connectmui).

 

 Using Connection Manager with Windows XP Service Pack 2

By default, computers using Windows XP Service Pack 2 will not allow access to the
Connection Manager server and VEE Service through the firewall.
If you have upgraded from another operating system version to Windows XP Service Pack
2, you must enable connections to the PC hosting the Connection Manager server and/or
VEE Service by listing them as exceptions to the firewall.

Follow these steps to enable network connections to Connection Manager server (and VEE
Pro, if necessary) through the firewall.

In the Windows menu bar, choose Start > Settings > Control Panel.1.
In the Control Panel dialog, click Windows Firewall.2.

In the Windows Firewall dialog, ensure that the Don't allow exceptions checkbox is3.
unchecked.
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In the Windows Firewall dialog, click the Exceptions tab.4.
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In the Exceptions tab, click Add Program....5.
In the Add a Program tab, click Browse.6.
Use the Browse dialog to enter the Connection Manager Server installation directory7.
(by default, <installation drive>\Program Files\Agilent\Connection Manager Server ).
From the Connection Manager Server installation directory, choose MsmtSrvr.exe8.
and click Open.
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In the Add a Program tab, click OK.9.
The Windows Firewall dialog Exceptions tab shows the MsmtSrvr.exe exception.
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If you are using VEE Service, in the Exceptions tab, click Add Program....10.
In the Add a Program tab, click Browse.11.
Use the Browse dialog to enter the VEE Pro installation directory (by default,12.
<installation drive>\Program Files\Agilent\VEE Pro 7.0 ).
From the VEE Pro installation directory, choose veesm.exe and click Open.13.
In the Add a Program tab, click OK.14.
In the Windows Firewall dialog, click the OK.15.

Connections to the PC hosting the Connection Manager server and/or VEE Service are now
enabled as firewall exceptions.

  

 Connection Manager Client
Connection Manager (CM) client, is the client half of the Connection Manager client/server
system. Although the server requires a version of Microsoft Windows 2000 Professional or
Windows XP Professional (or one of it's successors), clients can exist on any platform
having TCP/IP networking capabilities.

The CM client creates ADS datasets, holds the results of S-parameter, spectrum, and
voltage waveform measurements, and provides measurement panels enabling interaction
with measurements located on the server.
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The client also provides instrument discovery by identifying instruments that are
connected to your server workstation. This enables the client to easily associate a
particular instrument with a particular measurement.

Note
The term measurement describes functions in a server library. Generally, a measurement includes
gathering physical data from one or more instruments, but is not limited to instrument control.

The client uses the menus to access file, server, instrument, window, and
help/troubleshooting functionality.

 

 File Menu

The File menu contains entries to save and recall application states and to exit the client.
For more information, see Understanding Application State Files.

 

 Server Menu

 The Server menu contains a single entry that allows you to specify a connection for the
remainder of the Connection Manager client session. For more information, refer to
Selecting a Server Workstation and Connection Port (connectmui) and Managing the Set
Server Dialog from the Client.

 

 Instruments Menu

The Instruments menu contains entries enabling dynamic instrument discovery and
rudimentary interactive instrument IO.

 

 The Remote Instrument Explorer

 This dialog queries connected instruments and lists the results of the query.

 

 Interactive IO

 This dialog provides some rudimentary interactive instrument IO capabilities. This
capability is used in troubleshooting simple instrument connectivity problems. Selecting
Server > Interactive IO opens the Interactive IO dialog.

To communicate with a specific connected instrument, select an instrument using the
Select Instrument drop-down list.
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You can select an instruction to send to the instrument by choosing from the Command or
Query drop-down list or by typing a command into that same field.

Note
The definition of the IEEE-standard commands in the Command or Query field are listed in most
instrument programming documentation. This documentation is available from the Agilent Developer
Network: http://adn.tm.agilent.com .

 You can specify a waiting period before an unsuccessful communication attempt is
aborted by changing the value in the Timeout in milliseconds entry field. The default is
five seconds.
 Different types of instruments use different character sequences to mark the end of an
instruction.

The EOL Sequence drop-down list enables you to select the correct command termination
for a specific instrument. Almost all new instruments use a new line character as the
instruction terminator, so the default entry in the drop-down control is \n, a common
representation for new line. The other termination sequences involve the use of the
carriage return character, commonly represented by the \r symbol.

http://adn.tm.agilent.com
http://adn.tm.agilent.com
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Click Send and Receive to send an instruction that results in the instrument placing an
immediate response on the interface bus. Generally, this type of instruction ends with a " ?
" character.

For example, the IEEE-488.2 standard command for an instrument identification query is
*idn?. To send an instrument identification query from the server to an instrument,
choose the setting shown in the following figure, and click Send and Receive to send
*idn? to the instrument and display the response.

Note
This dialog can only read instrument response data in text format. Attempting to read a response that
contains binary data will result in an error.

Click Send Command to send a command that does not prompt a response. For
example, use this button to send *.cls to clear the instrument buffer.

Click Read Response to read data from an instrument independent from a transmitted
instruction. Some instruments can sample continuously. To get several samples of
information, send a command to start the instrument sampling, then select the Read
Response button several times.
  Click Send Device Clear to send the IEEE-488 bus command for selected device clear.
This command is a high-priority bus command (superseding ordinary instructions) that
forces an instrument to abort its current function and return to an idle state in order to
regain control over an instrument.

 The Session History is an edit field that logs the instructions you send to an instrument
and the instrument's responses to those commands. To delete the contents of this field
click Clear Session History.

 

 Measurements Menu
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The Measurements menu provides access to behavioral modeling, S-parameter, spectrum,
and voltage waveform measurements located on the server. For more information, see
Understanding the Measurement Panels.

For a list of instrument model numbers compatible with the measurements provided by
the Connection Manager Measurement panels, in the Connection Manager client window,
click Help > Supported Instruments... .

Note
Though the N5230A PNA network analyzer can measure S11 through S44 via Connection Manager,
Connection Manager cannot be used to make differential measurements.

 

 Windows Menu

The Windows menu provides control over the function of the measurement panels
contained within the client main window.

Choose Tile to resize the contained dialogs, arranging them so that they fill the entire
client window without overlapping.

Choose Cascade to arrange the contained dialogs so that they overlay each other with
the upper left corner of each dialog offset down and to the right of the dialog it covers.

 

 Help Menu

The Help menu contains access to documentation and support, as well as access to server
diagnostics and a list of supported instruments . For more information, see Connection
Manager Server Diagnostics (connectmui).

 

 Managing the Set Server Dialog from the Client

The check box labeled Do not prompt me again enables you to select whether the server
connection dialog displays when you select any of the entries in the Server, Instruments,
or Measurements menus.
Selecting this check box directs all further activities to the server identified when you
dismissed the Set Server dialog. Leaving this box cleared, causes the CM client to display
the Set Server dialog every time you select from the Server, Instruments, or
Measurements menus.

Note
In a case where a client is connected to several different servers, leave this check box unselected. You can
have multiple instances of the measurement panels and discovery dialogs point to multiple servers.

The information governing whether the Set Server dialog is displayed is stored in the XML
file named CM_InitConfig.cml, under the < ADS Home > /hpeesof/config directory. The file
contains the following command line:
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<MsmtClientInitConfig StartupDlgChecked="0" RemoteHost="localhost" Port="4790"

ServerDlgChecked="0" />

The ServerDlgChecked value determines whether the Set Server dialog is displayed.
Entering 0 displays the dialog, entering 1 suppresses it.
 This file also records the default value of server host and port number.

 

 Understanding Application State Files

 Using the File menu you can save and recall application state and exit the client.
By default, Connection Manager stores its application state in the workspace data
directory as an XML file. You can also store application state data in a user-defined
directory.
Following is an example of a Connection Manager application state file.

- <MsmtClientConfig Version="1.0" RemoteHost="localhost" Port="4790"

ServerSelected="0">

<InstExplorer RemoteHost="localhost" Port="4790" />

   - <Measurements>

     - <SParm8753 RemoteHost="localhost" Port="4790">

<VisaRsrc Value="GPIB0::16::INSTR" />

<QueryInstId Value="0" />

          - <SelectMeasurements>

<S11Msmt Value="1" />

<S12Msmt Value="1" />

<S13Msmt Value="0" />

<S21Msmt Value="1" />

<S22Msmt Value="1" />

<S23Msmt Value="0" />

<S31Msmt Value="0" />

<S32Msmt Value="0" />

<S33Msmt Value="0" />

</SelectMeasurements>

            - <ExportTextFile Value="0">

<FileType Value="0" />

</ExportTextFile>

<DataSetName Value="Ag8753" />

<BlockName Value="All4" />

</SParm8753>

</Measurements>

</MsmtClientConfig>}}

 

 Understanding the Measurement Panels

Measurement panels are measurement-specific, not instrument-specific. Because these
dialogs do not interact with schematics, the Connection Manager Client window manages
and groups the measurement panels.
All measurement panels have Measure and Help buttons.

Click Measure to execute the configured measurement.
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Click Help to access Connection Manager documentation.

 

 Common Functional Groups

Many of these measurement panels have a common subset of controls used to collect the
information needed to record an ADS dataset. Some measurement panels provide a
limited set of controls to setup an instrument and gather data from a manually configured
instrument.

Some measurements do not require the use of these programmatic controls. For example,
the S-parameter measurements assume a valid network analyzer calibration. Changing an
instrument configuration programmatically could invalidate the calibration. In this
instance, the measurement control dialog omits controls that could cause the instrument
to make a measurement without a valid calibration.

 

 Select Instrument

 

Every measurement panel contains the Select Instrument group. It is used to query, view,
and select connected instrumentation, control the automated instrument identification
process, and in some cases reset instrument states.

 

 Refresh

Click Refresh to repopulate the drop-down list with the latest instrumentation configured
on the server.

 

 Select Instrument

Use the drop-down list to view the connected instrumentation and choose an instrument
for a given measurement. The information displayed in the list is the same information
found in the Remote Instrument Explorer.

  

 Override instrument model check

Select the check box labeled Override instrument model check to disable the automated
instrument identification process. Leaving this check box deslected queries an instrument
for its identification string and verifies that the instrument is a particular model number or
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belongs to a particular family at the beginning of the measurement.

Select this check box if an instrument's instruction set is compatible with a given
instrument or family, but is not specifically listed in the measurement. Deselect this check
box if a measurement must be performed by a specific model number or family of
instruments.

For example, to make a voltage waveform measurement using an instrument with an
Agilent 86100-compatible instruction set, selecting this check box would allow the
measurement to execute on the unlisted oscilloscope without returning an error.

Note
Measurements have only been tested with the instruments identified in the measurement panel. Using an
unlisted instrument may result in inaccurate measurement data.

 

 Select Measurement

 Every measurement panel contains the Select Measurement group, used to select a
specific measurement or series of measurements. The dialog displays measurements
appropriate to the instrument driver: S-parameters, trace, channel, and memory.

 

 Select All

Click Select All to choose all available measurements.

 

 Clear All

Click Clear All to deselect all selected measurements.

 

 Save Dataset

 Every measurement panel contains the Save Dataset group. It is used to construct an
ADS dataset from measured data.

The entry field labeled Dataset Name contains the file name of the destination ADS
dataset. Every measurement creates a temporary dataset file in the workspace data
directory.

When a measurement completes successfully, the temporary dataset file is renamed as
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specified in the Dataset Name field. When a measurement does not run to completion, the
temporary dataset file will remain in the workspace data directory to try to preserve as
much information as possible.

 

 Browse...

Click Browse... open the Export dialog where you can choose a folder and select an
existing file name or enter a file name for the exported measurement data. In the case
where you specify the name of an existing dataset, its contents will be replaced with the
contents of a new measurement.

The Block Name field holds the name of a containing variable that holds the actual
measurement variables. This enables you to select measurement values of the same name
from different measurement runs. Normally, a measurement creates a dataset, holding a
single block filled with all the variables representing the various pieces of measured data.
There are occasions where this is not true.

Each measurement creates a temporary dataset file prefixed by two underbars (_) in the
_\Protect Data directory. Upon successful completion of the measurement, the temporary
dataset file is renamed using the value entered in the Dataset Name: field.

Though not specifically part of the dataset group, selecting the Measure button confirms
the measurement configuration before executing the hardware commands. The client tells
the server to make the measurement, sending the information gathered in the
measurement panel as configuration data.

 

 Understanding S-Parameter and Behavioral Modeling
Measurements

This section explains S-parameter data formatting, dataset and data file referencing, and
an overview of the measurement panel functionality.

Note
Connection Manager can only use S-parameter data that contains both magnitude and phase information,
as found in vector network analyzers. Scalar analyzers do not provide information in a format suitable for
use with Connection Manager.

 

 Matrix and Non-Matrix Variable Formatting for S-Parameter Data

Depending on the available instrumentation, Connection Manager can perform 2-, 3-, and
4-port S-parameter measurements.

The format of the variable names stored in an S-parameter dataset depend on the
measurements selected. There are two variable name formats used in S-parameter
datasets:
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a matrix notation 
a non-matrix notation

The matrix notation is used when you select all measurements needed to fully populate a
matrix for a given number of ports, the minimum number being two ports.

The matrices for a 2-port measurements will contain the variables:
S[1,1] S[1,2] S[2,1] S[2,2]
3-port matrices contain:
S[1,1] S[1,2] S[1,3] S[2,1] S[2,2] S[2,3] S[3,1] S[3,2] S[3,3]
4-port matrices contain:
S[1,1] S[1,2] S[1,3] S[1,4] S[2,1] S[2,2] S[2,3] S[2,4] S[3,1] S[3,2] S[3,3] S[3,4]
S[4,1] S[4,2] S[4,3] S[4,4]

Non-matrix formatting is used for individual S-parameter measurements, or
measurements that do not contain all of the 2 or 3-port data. In non-matrix formatting,
the variable names take the form s1_1, s1_2, s2_1, s2_2 and so forth.

You must differentiate between a fully-populated and a partially-populated matrix.
Expression evaluators in the Data Display Server and in simulation components make
simplifying assumptions when they encounter variables named using matrix notation.
Those assumptions enable faster lookup for matrix variables, but depend on a particular
layout and ordering of the stored data. The absence of data within the matrix data cause
the matrix evaluation expressions to fail.

 

 S-Parameter Data Acquisition

The most common reason for measuring S-parameters is to use the data in an S-
parameter simulation. To be useful in an S-parameter simulation, the measured data must
be stored in the dataset as real and imaginary pairs. Because the instruments will return
data in differing formats (depending on the analyzer's data display configuration), when
the Connection Manager reads the measured data from the instrument, it will momentarily
switch the display to a Smith chart. When displayed this way, the instrument returns data
in real and imaginary pairs required for an ADS dataset.

Note
This momentary change in display format does not compromise the measurement integrity. When finished
gathering data, Connection Manager restores the instrument data display to its original format.

Earlier versions of Connection Manager acquired S-parameter data prior to the analyzer
formatting the data for display on the analyzer's front panel. With ADS 2004A, Connection
Manager now acquires S-parameter data after the data has been formatted to display real
and imaginary pairs (represented as a Smith chart).

If you require a particular S-parameter representation, configure the instrument in the
same manner you want the measured data stored in the dataset. If you want to store raw
data, turn off corrections on the instrument. If you want to store corrected data, turn on
corrections on the instrument. If you want to store data that includes electrical delay, set
the instrument to a display mode that includes electrical delay and apply the required
delay. This is a change from previous versions of ADS, where only corrected data was
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stored.

Because the Connection Manager reads S-parameter data from the display buffer, any
electrical delay you add to the measurement will be included in the data stored in the
dataset. When displayed in an ADS data display window Smith chart, you can observe the
electrical delay. DDS displays that do not show phase information, such as the rectangular
plot displaying the data in dB, will look the same as any instrument display that doesn't
show phase information, for example the Log Magnitude format.

 

 Sweep Configuration

Connection Manager will not automatically acquire a new data sweep when asked to
return measured data.

If the instrument is in hold mode, executing a measurement from the client returns the
last data stored to the instrument memory.

To gather all of the data traces from the same sweep, configure the instrument to take the
required measurements using the required conditions, then trigger a single sweep on the
instrument. When the sweep is complete, the instrument enters hold mode, allowing the
transfer of all the trace data into a dataset without taking a new sweep.

The single exception to this is the PNA power-swept measurement. When asked to
retrieve data, the PNA power-swept measurement will always initiate a new sweep.

If you are using the 8753 power-swept measurement, make sure the instrument is set to
trigger continuously.

  

 Exporting S-Parameter Data to Text Files

The S-parameter measurement panels provide data export functionality through the
Export Data group box.
There are five File Type options:

AmplifierP2D (use with AmplifierP2D (ccsys) circuit component)
AmplifierS2D (use with AmplifierS2D (ccsys) circuit component)
AmpSingleCarrier (use with AmpSingleCarrier (ccsys) circuit component)
GainRF (use with GainRF (timed) signal processing component)
All-4-Formats

Data exported to an S2D file must meet the following requirements:

The file must contain at least one GCOMPx x:{1,2,...,7} block
It may contain an ACDATA and/or and NDATA block (and/or an IMT block)
It may be multi-dimensional. For example, it may contain VAR statements above
each basic S2D block.
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The contents of such an S2D file may be distributed to the following models in the
following capacities:

AmplifierS2D can read multi-D S2D files (including ACDATA, GCOMPx and NDATA)
blocks and is highly recommended for generic use. It is mounted on top of Amplifier2
so all FILE-mode properties of the latter are preserved. See also, AmplifierS2D
component documentation.
Amplifier2 can read 1-D S2D files (only reads the GCOMPx block) if placed in FILE-
mode. Its small signal parameters and noise parameters need to be supplied
manually at run time. Less effective for using direct instrument read data. See also,
Amplifier2 component documentation.
Both AmplifierS2D and Amplifier2 can create odd order harmonics and IMDs to some
degree of accuracy and model nonlinear noise, but cannot handle gain expansion
very well because of the polynomial curve fitting constraints. See also, AmplifierS2D
component documentation.

AmpSingleCarrier is not recommended because it contains a subset of the functionality
available with AmplifierS2D (for example, AmpSingleCarrier does not provide harmonic
modeling). If non-poly fitted single carrier modeling is required, AmplifierP2D handles full
2-port S-parameters. See also, AmpSingleCarrier component documentation.

AmplifierP2D is recommended for all single carrier applications. It can handle small signal
noise and full 2-port large signal nonlinearity. It does not have problems handling
arbitrary compression curves because it data fits by direct interpolation of P2D file data.
See also, AmplifierP2D component documentation.

 

 Behavioral Modeling (Power Swept S-Parameter) Measurement Panels

 This measurement is available for two network analyzer families, the Agilent
8753/8722/8720/8719 Network Analyzer Family and the Agilent ENA B and PNA Series
Network Analyzer Families.

Note
Instruments in the Agilent 8753/8722/8720/8719 Network Analyzer Family have varying capabilities to
make S-parameter measurements. Instruments with an " ET " designation have only transmission and
reflection test sets, and are not capable of making a full suite of S-parameter measurements. Instead,
they measure transmission and reflection only on one port.

The Power Swept S-Parameter Measurement panels contain five sections.



Advanced Design System 2011.01 - Connection Manager

56

 

 Select Instrument

Use this section to select and initialize the instrument used for data collection.

The drop-down list shows the VISA identification strings of all instruments connected to
the server. You can either select a VISA identification string from this list or type in any
valid VISA identification string corresponding to an instrument connected to the server.
After a new interface is created, use the Refresh button to update the instruments on the
Select Instrument drop-down list.

The check box labeled Override instrument model check determines whether the
measurement queries an instrument for instrument model, its identification number or its
identification string, and verifies that the instrument is a particular model number or
belongs to a particular family. This identification takes place once at the beginning of the
measurement. If you know that a measurement needs to take place only on a certain
model number of instrument or family of instruments, leave this box cleared. If you want
to use an instrument whose instruction set is compatible with a given instrument or
family, but is not specifically listed in the measurement, then check this box.
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Note
Measurements have only been tested with the instruments identified in the measurement panel. Using an
unlisted instrument may provide inaccurate results.

 

 Select Power Settings

 Use this section to specify the power range over which the stimulation power is swept.

Power sweep always starts from the minimum power and ends at the maximum power. If
the specified Start Power is higher than Stop Power, they are swapped.

If any of the specified power entries cannot be set correctly (usually out of range) during
the measurement, the measurement stops and no data file/dataset is generated.
P2-P1 Power Offset can be set to a non-zero value in order to offset port 2 power from
port 1 power. Only the Amplifier P2D file can reflect the power offset. Other data files and
datasets only record the P1 power.
If P2-P1 Power Offset is set to a non-zero value, for example 5 dB, Agilent
E88XX/E83XX/N338X network analyzers uncouple port 1 and port 2 automatically.
However, for Agilent 8753/8722/8720/8719 network analyzers, port 1 and port 2 must be
uncoupled manually. Otherwise, the measurement will warn out and stop.

Note
Agilent E88XX/E83XX/N338X network analyzers turn off auto attenuator control during the measurement
for better accuracy.

 

 Select Measurement

 Use the check boxes in this section to select the S11, S12, S21, and S22 measurements.

Note
At least one of the check boxes must be selected to proceed.

 

 Export Data

Use this section to choose a file name and export an ASCII text file.

 There are five File Type options:

AmplifierP2D
AmplifierS2D
AmpSingleCarrier
GainRF
All-4-Formats

Selecting a file type from the drop-down list produces a file in that format. Selecting All-
4-Formats generates four data files, one of each type.
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Entering a file name with an extension is not recommended. A .p2d, . s2d, .sc, or .txt is
automatically appended to the File name for each of the file types respectively.

Note
_ Save Data File_ is only active if the Export to Text File check box is selected.

For more information, see Exporting S-Parameter Data to Text Files.

 

 Save Dataset

 Use this section to specify the dataset and block name for saving trace data.

 

 Measure

Select the Measure button to perform the measurement. At this point data is saved in the
specified dataset.

Note
While the measurement is running, the measurement panel is disabled. Upon completion, a Measurement
complete dialog box appears. Select OK to dismiss.

 

 Measurement Results

The following data display shows the typical results from a measurement performed with
an Agilent E8364A.

The following screen shot shows part of the generated MeasuredByAgilentPNA.p2d file
performed with the  Agilent E8364A.
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 S-Parameter Measurement Panels

2-Port, 3-port, and 4-port S-parameter measurement using one or more instruments from
the following network analyzer families:

Agilent 8753/8722/8720/8719 Network Analyzer Family
Agilent 8712/8714 Network Analyzer Family
Agilent ENA B and PNA Network Analyzer Families
Agilent 8510 Network Analyzer Family

The S-Parameter Measurement panels contain of four functional sections.



Advanced Design System 2011.01 - Connection Manager

60

 

 Select Instrument

 Use this section to select and initialize the instrument used for data collection.

The drop-down list shows VISA identification strings of all instruments connected to the
server. You can either select a VISA identification string from this list or type in any valid
VISA identification string corresponding to an instrument connected to the server. After a
new interface is created, use the Refresh button to update the instruments on the Select
Instrument drop-down list.

The check box labeled Override instrument model check determines whether the
measurement queries an instrument for its identification string and verifies that the
instrument is a particular model number or belongs to a particular family. This
identification takes place once at the beginning of the measurement. If you know that a
measurement needs to take place only on a certain model number of instrument or family
of instruments, leave this box cleared. If you want to use an instrument whose instruction
set is compatible with a given instrument or family, but is not specifically listed in the
measurement, then check this box.
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Note
Measurements have only been tested with the instruments identified in the measurement panel. Using an
unlisted instrument may provide inaccurate results.

 

 Select Measurement

 Use this field to select which S-parameter(s) from S11, S12, S13, S21, S22, S23, S31,
S32, and S33 are measured. The S11 measurement uses port 2 as load port, S22 and S33
measurements use port 1 as load port.

4-port measurements are available with the ENA B family of network analyzers. The Select
All and Clear All functions in the Select Measurement section are useful in selecting or
clearing all the boxes without having to make individual measurement selections.

Note
The ENA family of instruments need to be individually configured to make 4-port measurements. For
information regarding making 4-port measurements, refer to the specific instrument's documentation.

Note
At least one of the check boxes must be selected to proceed.

 

 Export Data

 Use this section to choose a specific file name and to export an ASCII text file. Use the
File Type drop-down list to choose one of two available file types - CitiFile or Touchstone.

Note
_ Save Data File_ is only active if the Export to Text File check box is selected.

 

 Save Dataset

 Use this section to specify the dataset and block name for saving trace data.

 

 Measure

Select the Measure button to perform the measurement. At this point data is saved in the
specified dataset.

Note
While the measurement is running, the measurement panel is disabled. Upon completion, a Measurement
complete dialog box appears. Select OK to dismiss.

 

 Measurement Results
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The following data display shows typical results from a measurement performed with an
Agilent E8364A.

The following screen shot shows part of a text file generated using the Save Data File
feature.
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 Understanding Spectrum Measurements

Spectrum measurements are available for three types of spectrum analyzers:

856XX Spectrum Analyzer Family
859XX Spectrum Analyzer Family
E444XA PSA Series spectrum analyzers

The Spectrum measurement panel collects frequency domain data into a dataset. To read
this data during a simulation, use the CM VSA E444xA Source (instruments) component.

Note
The only differences between the three Spectrum Measurement panels are the title bars and trace names.

The Spectrum Measurement panels contain five sections.
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 Select Instrument

Use this section to select and initialize the instrument used for data collection.

The Select Instrument drop-down list shows the VISA identification strings of all
instruments connected to the server. You can either select a VISA identification string
from this list or type in any valid VISA identification string corresponding to an instrument
connected to the server. After a new interface is created, use the Refresh button to
update the instruments on the drop-down list.

The check box labeled Override instrument model check determines whether the
measurement queries an instrument for its identification string and verifies that the
instrument is a particular model number or belongs to a particular family. This
identification takes place once at the beginning of the measurement. If you know that a
measurement needs to take place only on a certain model number, leave this box cleared.
If you want to use an instrument whose instruction set is compatible with a given
instrument or family, but is not specifically listed, then check this box.
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Note
Measurements have only been tested with the instruments identified in the measurement panel. Using an
unlisted instrument may provide inaccurate results.

 

 Reset instrument on initialization check box

Select this check box to reset the spectrum analyzer to a preset state before executing a
measurement.

Use this function when the measurement instructions would otherwise be invalid given the
current the spectrum analyzer configuration.

If the Reset Instrument on Initialization check box is selected, the instrument is reset, any
prior setup is lost, and the instrument returns to the factory default state. This is used in
cases where the instructions a measurement sends to an instrument are not valid for the
instrument configuration.

 

 Select Frequency Settings

 The Frequency Selection section is used to specify the frequency range over which the
spectrum measurement is performed.

Selecting Use Current Instrument Settings performs a spectrum measurement over the
last specified range. If the Reset Instrument on Initialization check box (in the
Select Instrument section) is also selected, then the measurement is performed over the
factory default range.

Selecting Center Frequency/Span defines a new frequency range. The values entered in
the Center Freq and Span fields and the values selected in the Units drop-down lists must
define a valid frequency range (Center Freq > 0, Span > 0, Center Freq - 0.5 × Span ≥
0), otherwise the measurement will stop.

Selecting Start/Stop Frequency defines a new frequency range. The values entered in the
Start Freq and Stop Freq fields and the values selected in the Units drop down lists must
define a valid frequency range (0 ≤ Center Freq < Stop Freq), otherwise the measurement
will abort.

Note
 Defining a new frequency range using the Center Frequency/Span or the Start/Stop Frequency radio
buttons may return unexpected results in the case where some traces are frozen. Traces can be in two
states: an update state, where each new sweep updates the trace in some way (when Clear Write, Max
Hold, or Min Hold option is selected) or a frozen state, where each new sweep leaves the trace unchanged
(when the View option is selected). If the View option is selected and new frequency range defined is not
the same as the one with which the trace was captured before being frozen, the frequency axis of the
trace read corresponds to the new frequency range and will be incorrect.

 

 Select Measurement
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 The Measurement Selection area is used to select which traces are read. The Agilent
856XX family supports only two traces, whereas the Agilent 859XX and E444XA families
support three traces.

Note
At least one of the check boxes in this area must be selected to proceed.

 

 Save Dataset

Use this section to specify the dataset and block name for saving trace data.

 

 Measure

Select the Measure button to perform the measurement. At this point data is saved in the
specified dataset.

Note
While the measurement is running, the Measurement panel is disabled. Upon completion a Measurement
complete dialog appears. Select OK to dismiss this dialog.

 

 Measurement Results

These are the results from a measurement performed using an Agilent E444XA and the
setup shown earlier. For this measurement, Trace1 was set to Max Hold and Trace3 was
set to Min Hold.
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 Understanding Voltage Waveform Measurements

Voltage waveform measurements are available for the following oscilloscopes:

Agilent 86100A oscilloscope
Agilent 5462X and 5464X Oscilloscope Families
Agilent 5485X and 5483X Oscilloscope Families

The Agilent 86100A, 5462X, and 5464X oscilloscopes require manual measurement
configuration from the instrument front panel.

The Agilent 5485X and 5483X oscilloscopes can be configured from the measurement
panel.

 

 Measurement Panels Requiring Manual Measurement Configuration

The measurement panels under this menu selection create datasets where the Y-axis
values represent sampled voltage data and the X-axis values represent the times at which
each voltage sample was taken.

Use the CM Infiniium 548xx Source1 (instruments) and CM Infiniium 548xx Source2
(instruments) components to read the data during a simulation.



Advanced Design System 2011.01 - Connection Manager

68

 

 Select Instrument

Use this section to select and initialize the instrument used for data collection.

The drop-down list shows the VISA identification strings of all instruments connected to
the server. You can either select a VISA identification string from this list or type in any
valid VISA identification string corresponding to an instrument connected to the server.
After a new interface is created, use the Refresh button to update the instruments on the
Select Instrument drop-down list.

The check box labeled Override instrument model check determines whether or not the
measurement queries an instrument for its identification string and verifies that the
instrument is a particular model number or belongs to a particular family. This
identification takes place once at the beginning of the measurement. If you know that a
measurement needs to take place on a certain model number of instrument or family of
instruments, leave this box unselected. If you want to use an instrument with an
instruction set compatible with a given instrument or family, but not specifically listed,
then select this check box.

Note
Measurements have only been tested with the instruments identified in the measurement panel. Using an
unlisted instrument may produce inaccurate results.

 

 Select Measurement

When stored in the dataset, each measurement selected creates a variable named
according to the name assigned to the measurement, Channelx or Memoryx in the case of
the Agilent 86100A oscilloscope or Channel 1 - Channel 2 in the case of the Agilent 5462x
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and 5464x oscilloscope families.

The Voltage Waveform Measurement - Agilent 86100A Oscilloscope dialog reads channel
and memory data from an Agilent 86100A oscilloscope. Some applications use the TDR
data captured by this instrument. To do this, select the channel that displays the TDR
trace.

Note
At least one of the check boxes in this area must be selected to proceed.

 

 Save Dataset

 Use this section to specify the dataset and block name when saving trace data.

 

 Measure

Select the Measure button to perform the measurement. At this point data is saved in the
specified dataset.

Note
While the measurement is running, the Measurement panel is disabled. Upon completion a Measurement
complete dialog appears. Select OK to dismiss.

 

 Voltage Waveform Measurements Using 5483X Family Oscilloscopes

When using these oscilloscopes with Connection Manager, all measurements must contain
equal numbers of trace data points.

Note
This measurement requires the instrument to have firmware revision A.02.30 or later. To view the
firmware revision, on the main instrument menu, click Help > About Infiniium. For firmware updates,
visit the Agilent web site.

 

 Matching Numbers of Trace Data Points

These instruments require datasets to have all the independent variables mapped over the
same dependent variable. If you select more than one measurement in the client window,
all the selected measurements must return the same number of trace points.

For example, if you select Channel 1 and Memory 1 it is important that Memory 1 contain
the same number of trace points as Channel 1. If the number of trace points differ, store
the data in separate datasets.

When copying a waveform to memory, follow these steps to set the memory trace to have
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the same number of points as a display trace.

From the instrument's Setup menu, select Waveform Memory... .1.
In the Waveform Memory Setup dialog, select Load from Waveform....2.
In the Load Waveform Memory dialog, select the All Data radio button.3.

 

 Measurement Panels With Client-Based Measurement Configuration

Connection Manager offers client-based measurement configuration using Agilent 5483XB
and 5485XB Oscilloscope Families. This measurement panel has extensive instrument
control capabilities in addition to the capability to store downloaded waveforms. The panel
groups the data gathering and instrument control functions into related tabs.

The buttons near the bottom of the panel download waveforms, send setup information to
the instrument, send setup information to the instrument, then immediately perform a
download, dismiss the dialog, and display context-sensitive help.

Note
This measurement requires the instrument to have firmware revision A.02.30 or later. To view the
firmware revision, on the main instrument menu, click Help > About Infiniium. For firmware updates,
visit the Agilent web site.
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 Select Instrument

Use this section to select and initialize the instrument used for data collection.

The drop-down list shows the VISA identification strings of all instruments connected to
the server. You can either select a VISA identification string from this list or type in any
valid VISA identification string corresponding to an instrument connected to the server.
After a new interface is created, use the Refresh button to update the instruments on the
Select Instrument drop-down list.

Note
Measurements have only been tested with the instruments identified in the measurement panel. Using an
unlisted instrument may produce inaccurate results.
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 Data Storage Tab

 

 Select Waveform(s)

Like the manually configured oscilloscope measurement Select Measurement group box,
the Channel and Memory check boxes select the data traces to store in a dataset.

The measurement stores these traces with dataset variable names identical to those used
in manually configured oscilloscope measurements.
Select All and Clear All are convenient ways to select and exclude all data and memory
channels from data download, respectively.

 

 Save Dataset

Use this section to specify the dataset when saving trace data. This measurement does
not include a block name field. In addition to being able to type the name of a dataset file
into the Dataset Name field, the Browse... button will display a file selection dialog that
you may use to select an existing data or specify a new one.

 

 Channel Settings Tab

This tab contains additional tabs that allow control of the instrument's vertical scale setup
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for channels having a physical input connector. Each acquisition channel is controlled
through a separate tab labeled Channel 1 through Channel 4.

Every control tab contains an Include panel contents in instrument upload check box.
When selected, the contents of the tab get transmitted to the instrument when you click
the Upload Settings. For example, the Channel 1 tab contents will be transmitted to the
instrument when the panel is configured as it is in the preceding screen shot.

Each channel is controlled independently, as are all memories. This allows adjustment of
particular instrument settings, while leaving all others unchanged.

The Display channel X check box determines whether or not the instrument will display
the associated trace on its screen. Selecting a channel for waveform download overrides
this setting. For example, if you turn off channel 2, but select it for download, the
oscilloscope will display channel 2 following the data download.

The Scale field sets the associated channel's vertical scale. The number in this field
corresponds to the instrument's Volts/division setting for a given channel.

The Offset field sets the vertical value that is represented at the center of the display for
the selected channel. Offset parameters are probe and vertical scale dependent.

 

 Timebase Settings Tab

The Timebase reference drop-down list selects the location of the time zero point on the
instrument display. Left puts time zero at the left edge of the display. Center puts time
zero in the middle of the display. Right puts time zero at the right edge of the display.
Anything to the left of time zero is data captured before the trigger event.

The Timebase scale field sets the instrument's horizontal scale. This field corresponds to
the instrument's time/division setting.

The Timebase delay field sets the time interval between the trigger event and the delay
reference point.

 

 Trigger Settings Tab
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The Trigger Settings group controls how the instrument takes a sweep.

When Trigger mode is set to Auto, the instrument is in free-run mode, requiring no
trigger event to take a sweep. When in Triggered mode, the instrument will continuously
take sweeps, as long as trigger conditions are met. When in Single mode, the instrument
will take one sweep when trigger conditions are met and then stop sweeping.

The instrument can use any of the active channels, the Aux connector on the back of the
instrument ( External ) or the AC power ( Line ) as the trigger source.

The settings in the Trigger levels group determine the voltage value at which the
instrument will take a sweep when the associated trigger source is active.

The Trigger slope setting determines whether the instrument considers the trigger point to
be the rising or falling edge of the signal selected as the trigger source.
Trigger holdoff specifies the amount of time the oscilloscope should wait after receiving a
trigger before enabling the trigger again.
Trigger hysteresis specifies the trigger hysteresis (noise reject) as either Normal or High
Sensitivity. Normal sensitivity adds hysteresis to the trigger circuitry for rejecting noise
and should be used for waveform frequencies at or below 4 GHz. High Sensitivity lowers
the hysteresis of the trigger circuitry and should be used for waveforms frequencies above
4 GHz.

The Trigger Levels group specifies the voltage level at which the instrument will take a
sweep when the corresponding trigger source is active.

 

 Memory Settings Tab
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This tab contains more tabs that control each of the instrument's waveform memories.

The Display memory X selection determines whether the instrument will display the
contents of the corresponding waveform memory. This setting is overridden by selecting
to download the associated waveform memory trace.

The X Range field sets the X-axis (horizontal) range for the selected waveform memory's
display scale. The horizontal scale is the horizontal range divided by 10.

The X Offset field sets the X-axis (horizontal) position for the selected waveform memory's
display scale. The position is referenced to center screen.

The Y Range field sets the Y-axis (vertical) range for the selected memory. The vertical
scale is the vertical range divided by 8.

The Y Offset field sets the Y-axis (vertical) position for the selected waveform memory.
The position is referenced to center screen.

  

 Advanced Tab

When selected, the Perform autoscale before acquiring trace data check box causes the
instrument to perform an autoscale operation before downloading the waveforms you
have selected on the Data Storage tab. Autoscale is a convenient way to have the
instrument determine the optimal settings for displaying the waveforms present on the
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input connectors.

The Time to wait to acquire exclusive instrument lock check box is an advanced setting
intended to allow you to determine how long to wait for a shared instrument to become
available for your exclusive use. If two clients want to use the same instrument at the
same time, the instructions getting to the instrument would be intermingled between the
different clients. To prevent this intermingling of instructions, the server locks an
instrument during the time a client is actively communicating with that instrument. When
a client is done, the server unlocks the instrument. This field specifies how long to wait for
a shared instrument to become unlocked (thereby granting access to it) before giving up.

The Time to wait for waveform transfer field specifies how long to wait for an instruction
sent to the instrument to complete its task before deciding that the instrument will most
likely never complete the task. For example, an instrument is set to trigger on an external
event and the event is expected to occur within 10 seconds. If that event never occurs,
the measurement would hang indefinitely. Use this field to specify how long to wait before
giving up.

Note
Increase this value when downloading large waveforms that may take a long time to transfer out of the
instrument.

Clicking Save Instrument State records the instrument's learn string (as specified by
the IEEE-488.2 specification) into a data file. Use this function to save redoing a
complicated instrument configuration. If undesired adjustments are subsequently made to
the measurement configuration, simply recall the stored setup into the instrument by
clicking Recall Instrument State.

Recall Instrument State allows you to select a file containing a previously-stored
instrument state to be sent back to the instrument.

Clicking Reset Instrument State sets the instrument to its default state by issuing the
IEEE-488.2 standard *RST command.

Clicking Clear Instrument Status clears the error status bit in the instrument's status
byte by sending the IEEE-488.2 standard command *CLS. Use this to clear an error
caused by a previous instruction that timed out.

Use the CM Infiniium 548xx Source1 (instruments) and CM_Infiniium_548xx_Source2
(instruments) components to read the data and to configure the Infiniium scope during a
simulation.

 

 Download Waveform(s)

Select the Download Waveform(s) button to capture the selected traces from the
instrument and store the data in the dataset. See Matching Numbers of Trace Data Points
for important information regarding waveform memory trace acquisition.

Download Waveform(s) is active only when the following conditions are met:
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One or more data or memory channels has been selected for download.
The Select Instrument drop-down list contains an entry.
The Dataset Name field contains an entry.

 

 Upload Settings

Every control tab includes an Include panel contents in instrument upload check box.
When selected, the contents of the tab are transmitted to the instrument when you click
Upload Settings.

For example, the Channel 1 tab contents will be transmitted to the instrument when the
panel is configured. Each channel is controlled independently, as are all memories.

This allows adjustment to some instrument settings, while leaving all others unchanged.
Upload Settings is active only when one or more of the Include panel contents in
instrument upload check boxes are selected.

 

 Upload then Download

Clicking Upload then Downloa d configures the measurement, acquires the trace or
memory data, and saves the data in a dataset. Upload then Download is active only
when both the Download Waveform(s) and Upload Settings buttons are active.

 

 Done

Click Done to close the measurement panel.

 

 Help

Click Help to access Connection Manager documentation.
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 Performing Connected Measurements
This section teaches you how to make connected measurements using the measurement
panels accessible through the Connection Manager client.

 Overview
From the Connection Manager client dialog, you can access 2-port power swept S-
parameter, S-parameter, spectrum, and voltage waveform measurements.
Connection Manager uses measurement panels to configure instruments, execute
measurements, and collect and format ADS datasets. Using these dialogs, you can easily
configure and perform measurements made available on the server.
For detailed information on the measurement configuration, see Understanding the
Measurement Panels (connectmui).

 

 Measuring S-Parameters
Connection Manger measurement panels enable behavioral modeling (2-port power
swept) measurements and 2-, 3-, and 4-port frequency swept S-parameter
measurements using the following network analyzer families. 
2-port power swept measurements available for:

8753/8722/8720/8719 network analyzer family
ENA B, ENA C, PNA, and PNA-X network analyzer families
2-, 3-, and 4-port frequency swept measurements available for:
8753/8722/8720/8719 network analyzer family
8712/8714 network analyzer family
ENA B, ENA C, PNA, and PNA-X network analyzer families
8510 network analyzer family

Note
In all cases, the instrument must return both amplitude and phase information. Scalar analyzers do
not provide information in a format suitable for use with Connection Manager.

Note
2-port measurements can be made on any combination of S11, S21, S12, and S22 parameters. The
following discussion is also relevant to measuring S11 on 1-port devices. The text can be interpreted by
the reader for such 1-port applications.

 

 To Measure 2-Port Power Swept S-Parameters 

This measurement is available for two network analyzer families, the Agilent 8753/
8722/8720/8719 Network Analyzer Family and the Agilent ENA B, ENA C, PNA, and PNA-X
Series Network Analyzer Families .
For detailed information regarding S-parameter measurement panel functionality, see
Understanding S-Parameter and Behavioral Modeling Measurements (connectmui).
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To make a 2-port power swept S-parameter measurement, complete the following steps.

Configure the frequency and power settings, and calibrate the network analyzer.1.
Insert the device under test into the measurement path.2.
Select Measurements > Behavioral Modeling > ENA B and PNA Network3.
Analyzer Families .
To update the Select Instrument list with the latest instruments configured on the4.
server, click Refresh .
Select the VISA resource connected to the network analyzer from the Select5.
Instrument drop-down list.
In the Select Power Settings group box Start Power (dB) data entry field,6.
enter -20 .
In the Stop Power (dB) data entry field, enter -10 .7.
In the Step (dB) data entry field, enter 1 .8.
Deselect all measurements except S11 .9.
Enter device1_psS11 in the Dataset Name field.10.
To send the client information in the Power Swept Measurement panel to the server11.
workstation, click Measure .
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The server processes the request and returns the results. The first time a
measurement is run, the server imports the drivers and libraries necessary for the
proper execution of the measurement. The results are stored in the dataset file.
These stored values can be used by Data Display and/or in a simulation.

Note
While the measurement is running, the Measurement window is disabled. When finished, a
Measurement complete window appears. Select OK to dismiss.

 

 To Measure 2-Port Frequency Swept S-Parameters

To make a 2-port S-parameter measurement, complete the following steps.

Configure the frequency and power settings, and calibrate the network analyzer.1.
Insert the device under test into the measurement path.2.
Select Measurements > S-Parameters > ENA B and PNA Network Analyzer3.
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Families .
To update the Select Instrument list with the latest instruments configured on the4.
server, click Refresh .
Select the VISA resource connected to the network analyzer from the Select5.
Instrument drop-down list.
Deselect all measurements except S11 .6.
Enter device1_S11 in the Dataset Name field.7.
To send the client information in the S-Parameter Measurement panel to the server8.
workstation, click Measure .

The server processes the request and returns the results. The first time a
measurement is run, the server imports the drivers and libraries necessary for the
proper execution of the measurement. The results are stored in the dataset file.
These stored values can be used by Data Display and/or in a simulation.

Note
While the measurement is running, the Measurement window is disabled. When finished, a
Measurement complete window appears. Select OK to dismiss.

For more information, see Understanding S-Parameter and Behavioral Modeling
Measurements (connectmui).
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 To Display the Measurement Data

 To view the measurement data in a Data Display window, complete the following steps.

From the toolbar in the schematic window select Window > New Data Display .1.
Select the device1_S11 dataset.2.
Select the Rectangular Plot button, then select inside the Data Display window to3.
open the Plot Traces & Attributes dialog box.

Note
The measurement variable is s1_1 . If only part of an S-parameter matrix is stored, the variable
names cannot use the standard matrix notation. If all four S-parameters are selected, and Measure
is selected again, the dataset variable naming conforms to the matrix notation.
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The following illustration shows the result of an S11 measurement displayed in the
Data Display window.
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 To Export the Measurement Data to a Text File

 Besides storing measured S-parameter data in a dataset, you can also export it to a text
file in  either CitiFile or Touchstone formats.
To export the S-Parameter measurement data to a text file, follow these steps.

Select the Export to Text File check box.1.
Select the file type to export from the File Type drop-down list.2.
Click Browse to select an existing file, or type the file name for a new file.3.
To record the data into the selected text file and dataset, click Measure .4.
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For more information on exporting S-parameter data, see Understanding S-
Parameter and Behavioral Modeling Measurements (connectmui).

 

 Measuring Frequency Spectrum
 Use the Spectrum measurement panel to gather frequency domain measurement data.
Spectrum measurements are available for three types of spectrum analyzers:

856XX spectrum analyzer family
859XX spectrum analyzer family
E444XA PSA Series spectrum analyzers

 

 To Measure Frequency Spectrum

For detailed information regarding frequency spectrum measurement panel functionality,
see Understanding Spectrum Measurements (connectmui).

To make a frequency spectrum measurement of a carrier at 2 GHz −10 dBm using an



Advanced Design System 2011.01 - Connection Manager

86

E444XA PSA, complete the following steps.

Preset the spectrum analyzer.1.
Connect the spectrum analyzer INPUT to the signal source.2.
On the PSA, set Trace 1 to Max Hold and Trace 3 to Min Hold.3.
Select Measurements > Spectrum > E444X Spectrum Analyzer Family .4.
To update the Select Instrument list with the latest instruments configured on the5.
server, click Refresh .
Select the VISA resource connected to the spectrum analyzer from the Select6.
Instrument drop-down list.
In the Select Frequency Settings group box, choose the Start/Stop Frequency7.
radio button.
In the Start Freq field and Units drop-down list, enter 1.998 and choose GHz .8.
In the Stop Freq field and Units drop-down list, enter 2.002 and choose GHz .9.
In the Select Measurement group box, select the Trace 1 and Trace 3 check boxes.10.
To send the client information in the Spectrum Measurement panel to the server11.
workstation, click Measure .

The server processes the request and returns the results. The first time a
measurement is run, the server imports the drivers and libraries necessary for the
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proper execution of the measurement. The results are stored in the dataset file.
These stored values can be used by Data Display and/or in a simulation.

Note
While the measurement is running, the Measurement window is disabled. When finished, a
Measurement complete window appears. Select OK to dismiss.

Note
While the measurement is running, the Measurement window is disabled. Upon completion a
Measurement complete window appears. Select OK to dismiss this window.

The following screen capture shows the results of the preceding measurement.

For more spectrum measurement information, see Understanding Spectrum
Measurements (connectmui).

 

 Measuring Voltage Waveform
  Use a Voltage Waveform Measurement panel to gather time domain measurement data.
Voltage waveform measurements create datasets where the Y-axis values represent
sampled voltage data and the X-axis values represent the times at which each voltage
sample was taken.

Voltage waveform measurements are available for the following oscilloscopes:

Agilent 86100A oscilloscope
Agilent 5462X and 5464X oscilloscope families
Agilent 5483X and 5485X oscilloscope families (with client-based instrument
configuration)
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When using the first three measurement panels, the client measurement panel configures
only data storage. You must manually configure channel, timebase, trigger, and memory
settings on the oscilloscope front panel before executing the measurement.

Using the Agilent 5483X and 5485X Oscilloscope Families measurement panel, you can
configure many oscilloscope settings and download the settings to the oscilloscope from
the client.
A cooperative protocol exists between clients and the server to prevent buffer overrun
caused by transferring waveforms with too many data points, allowing the transfer of
waveforms containing as many data points as the oscilloscope can store.

The 5483x and 5485x oscilloscope measurement checks to see that the corresponding
server library is at the correct revision to support buffered transfers.

The state of the instrument is set during its use and is not reset to its initial state after
use. Customer needs to rely on manual reset of the instrument to its former state as
desired, such as instrument internal interpolation state, after its use.

Caution
Use caution when transferring large waveforms, as doing so results in extremely large data set files.

 

 To Measure Voltage Waveform

The following example uses the Agilent 54832B Infiniium oscilloscope to make a voltage
waveform measurement. This measurement includes instrument configuration from the
client measurement panel.
For detailed information regarding voltage waveform measurement panel functionality,
see Understanding Voltage Waveform Measurements (connectmui).

To configure the instrument and perform the measurement, complete the following steps.

Connect the oscilloscope channel 1 INPUT to the signal source.1.
From the client, select Measurements > Voltage Waveform > 5485X and 5483X2.
Oscilloscope Families .
To update the Select Instrument list with the latest instruments configured on the3.
server, click Refresh .
Select the VISA resource connected to the oscilloscope from the Select Instrument4.
drop-down list.
In the Data Storage tab, select the Channel 1 , Memory 1 , Channel 2 , and5.
Memory 2 check boxes. In the Dataset Name entry field, enter VoltageWaveform1 .
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In the Channel Settings tab, choose the Channel 1 tab and enter 2 V for the Scale,6.
select the Display channel 1 and the Include panel contents in instrument
upload check box. Choose the Channel 2 tab and select the Display channel 2 and
the Include panel contents in instrument upload check box.
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In the Timebase Settings tab, choose Left from the Timebase Reference drop-down7.
list and select the Include panel contents in instrument upload check box. In
the Timebase Scale entry fields, enter 20 ns .
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In the Trigger Settings tab, choose Channel 2 from the Trigger source drop-down list8.
and select the Include panel contents in instrument upload check box.
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In the Memory Settings tab, choose the Memory 1 tab and select the Include panel9.
contents in instrument upload , and Display memory 1 check boxes. Choose the
Memory 2 tab and select the Include panel contents in instrument upload , and
Display memory 2 check boxes.
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In the Advanced tab, select the Override instrument model check check box.10.

Note
Selecting the Override instrument model check check box is necessary only when using an
unsupported oscilloscope. Other oscilloscopes will most likely use the same instruction sets as the
Agilent 54832X or 54855X.
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Click Apply then Download .11.
The following screen capture shows the results of the preceding measurement using
the Data Display server.
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For more spectrum measurement information, see Understanding Voltage Waveform
Measurements (connectmui).
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 Troubleshooting Connection Manager
This section offers solutions to common installation, configuration, and instrument
communication problems, as well as instruction on using the server diagnostics tools

  

 Server Installation and Configuration
This section lists common Connection Manager server installation and configuration
problems and their possible solutions.

 

 Server IO Fails Running Under the LocalSystem Account

When running the Connection Manager as a Windows service (see Running the Server as a
Windows Service (connectmui)) and trying to connect to the CM ESG E4438C Sink
(instruments) (or other CM component), the following error message (or a message
announcing the VISA32.dll did not load) is displayed.

 

 Solution: use a named account.

Run the Connection Manager Server under an account with Administrator privileges.
The problem is a conflict involving the SICL interface and Connection Manager interface on
certain PCs. In some cases, Connection Manager cannot be run as a LocalSystem account
service.

 

 To check if Connection Manager is running under a LocalSystem Account:

From the Windows toolbar, click Start > Settings > Control Panel.1.
In the Control Panel dialog, click Administrative Tools.2.
In the Administrative Tools dialog, click Services. (If you do not have access to the3.
Services icon from the Administrative Tools dialog, see following section.)
In the Services dialog, right-click on the Agilent Connection Manager and select4.
Properties.
In the Properties dialog, select the Log On tab.5.
Observe the Log on as: setting.6.



Advanced Design System 2011.01 - Connection Manager

97

If your PC is set to LocalSystem account, follow the instructions in Configuring User
Account Privileges on the PC. (connectmui)

 

 If you do not have access to the Services icon from the Administrative Tools dialog

Some PCs may not have the Services shortcut available in the Administrative Tools
dialog. If so, follow these steps.

In Windows Explorer, navigate to %SystemRoot%\system32 to find the services.msc1.
(Microsoft Common Console Document). For example,
C:\WINNT\system32\services.msc.
Double-click on the services.msc file to bring up the Services dialog.2.
In the Services dialog, right-click on the Agilent Connection Manager and select3.
Properties.
In the Properties dialog, select the Log On tab.4.
Observe the Log on as: setting.5.

If your PC is set to LocalSystem account, follow the instructions in Configuring User
Account Privileges on the PC. (connectmui)

 

 No Connection and "Connection Refused" Error Messages

 

 Solution: for systems with firewalls, specify the server port number to allow access.

Firewall software, like Norton Internet Security, Zone Alarm, or the Windows XP Personal
Firewall application, can interfere with the server's ability to communicate on a network.
This will manifest itself as the client application receiving a Connection Refused message
when trying to run a measurement.
Most of these applications allow you to configure the server to allow certain applications to
access the network. For firewall software applications that require the port number for the
CM server, see the C:\Program Files\Agilent\Connection Manager
Server\MsmtSrvr.exe.config file for the configured port number the server uses to
communicate with clients.
The server uses transient ports, which allow for faster data transfer. The ports are
allocated dynamically, starting with port number 5001,extending to 10,000.

 

 Solution: determine if another process is binding the port and reconfigure.

The server allows network communication from clients by listening to a port identified in
the MsmtSrvr.exe.config file. If the server cannot bind the port, possibly because another
application is using that port, the client will get " connection refused " messages.
In addition, the server machine will run slowly. The server will try to restart itself in the
event that it exits abnormally. Failure to bind to the port in the MsmtSrvr.exe.config file



Advanced Design System 2011.01 - Connection Manager

98

will cause an abnormal exit. Continued failure to bind the port will cause the server to
continually try to restart, resulting in a slow server PC.
You can determine if there is a port conflict by running the command " netstat -a " from a
command prompt on the server PC.
If the client receives a message that the connection has been refused and the server
becomes very slow, it is probable that the server port is being used by another process. 
To verify this problem, complete the following steps:

From the Windows tool bar, select Start > Settings > Control Panel >1.
Administrative Tools > Services __ to open the Services window.
Highlight Agilent Connection Manager.2.
Select Action > Stop to stop the Connection Manager service.3.
Open a Command Prompt window and type:4.
netstat -a

Press Enter.5.

This provides a list of active connections on the server workstation. If the port number
used by Connection Manager is present in the Active Connections list, another process is
using the Connection Manager port.

If this is the case, you must either stop this process to free the port or select a new port
for use by Connection Manager. To change the server's port number, refer to The
MsmtSrvr.exe Process (connectmui).

To solve this problem, stop the server using the Windows Services control panel applet,
change the server's port entry in the MsmtSrvr.exe.config file, and restart the server.
Since the clients and server must agree on this port number, change the client parameters
to use the port value you just put into the MsmtSrvr.exe.config file.

Note
The  Process Explorer tool available from SysInternals, http://www.sysinternals.com/  , can help to
determine if the cause of refused connections is due to abnormal server termination. If you see the server
process (MsmtSrvr.exe) highlighted in red, it (the server) is continuously re-spawning.

 

 Measurements Using Plug and Play Drivers Fail

 

 Solution: install the required the required driver(s).

Several measurements depend on having Plug and Play drivers installed on the server PC.
If a required driver is not available, the client displays an error dialog, as shown.

http://www.sysinternals.com/
http://www.sysinternals.com/
http://www.sysinternals.com/
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To correct this, you must install the driver on the server PC. Drivers are available at the
Drivers and Downloads link at the Agilent Developer Network web site:
http://www.agilent.com/find/adn

 

 Solution: install the Agilent IO libraries with Agilent VISA set to Primary.

Some of the Connection Manager measurements achieve instrument control by using Plug
and Play drivers. Those drivers depend on an Application Programming Interface known as
VISA to communicate with instruments. There are two major vendors supplying VISA
implementations. Those implementations are not necessarily compatible, so, when
installing the Agilent IO Libraries, you may be presented with the need to choose between
installing Agilent VISA as either Primary or Secondary. Always install the Agilent VISA
Libraries as Primary. For a complete description of this topic, refer to the Agilent IO
Libraries and NI Software document found at:
http://www.agilent.com/find/iolib .
You can determine if your IO libraries have VISA installed and if VISA is installed as
Primary by selecting the About Agilent IO Libraries Control entry from context menu
in the IO libraries icon in the task bar.
To install the IO libraries with VISA as primary, run the IO libraries installation on the PC
server, select the custom installation button, then select the option that does a full
installation with VISA as primary.
Part of the process of installing a Plug and Play driver causes the driver to record where it
finds its VISA library. If you upgrade or otherwise replace the IO Libraries installation and
change the installation from primary to secondary ( or vice versa), the Plug and Play
driver may not be able to find its VISA implementation. This results in a measurement
displaying an error dialog indicating that the T&M Toolkit's driver interoperation layer
encountered a failure trying to call the driver's Init function.
The solution is to uninstall the IO libraries and reinstall with VISA as primary. Then
uninstall and reinstall the Plug and Play driver. Drivers are available at the Drivers and
Downloads link at the Agilent Developer Network web site:
http://www.agilent.com/find/adn
For support installing and configuring the Agilent IO Libraries and for answers to your
hardware or measurement questions, contact your local Agilent Instrument Support
Center at the number found on the following website:
http://www.agilent.com/find/support

 

http://www.agilent.com/find/adn
http://www.agilent.com/find/adn
http://www.agilent.com/find/iolib
http://www.agilent.com/find/iolib
http://www.agilent.com/find/adn
http://www.agilent.com/find/adn
http://www.agilent.com/find/support
http://www.agilent.com/find/support
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 Server Unregisters After Installing 2003C then Uninstalling 2003A

 

 Solution: restart the measurement server from the control panel applet.

Part of the uninstalling process unregisters the Connection Manager Server - a Windows
service. Since this is a system component, only one instance may be actively registered
on a system. When installing the server, the system registry gets updated to use the
server in whichever version of ADS is being installed. Likewise, uninstalling deletes the
registry entries related to the server.
If you install 2003A, then install 2003C, the registry uses the 2003C server. If you
subsequently remove 2003A, the server registry entries will be removed, and the server
will no longer be configured.
To configure the server, open a command window on the server workstation and perform
the following procedure:

From the <ADS Installation Directory Path>/bin directory, enter MsmtSrvc -install .1.
Open the Services control panel applet and select the Agilent Connection Manager2.
entry's properties.
Select the login account you wish the server use.3.
Select the server startup option.4.
Start the service running by choosing Start from the control panel applet.5.

 

 Missing Blue IO icon in System Icon Tray

 

 Solution: uninstall ADS 2003C server and install ADS 2004A server.

The blue IO icon must be active in the Windows system icon tray for the Connection
Manager server to run.

The IO Libraries installation places a shortcut to the IO Libraries application called iprocsvr
in the system program startup group. Iprocsvr is the entity responsible for putting the IO
icon in the system icon tray. If iprocsvr is not running on the server PC, instrument IO will
not function.
The IO Libraries will not operate when there is no interactive logon session running on the
CM server workstation. This prevents the CM server from performing instrument IO unless
a user is interactively logged onto the server PC.
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 ADS 2003C and Earlier Running Server as Windows Service

As a work around, the ADS 2003C CM Server installation removed the iprocsvr shortcut.
At startup, the ADS 2003C server would check to see if iprocsvr was running. If not, the
ADS 2003C server would start iprocsvr.
Running the 2003C server uninstall will restore the iprocsvr shortcut to the system
program startup group.
ADS 2004A Running Server as Windows Application
To integrate better with the IO Libraries, the 2004A CM server runs as a Windows
application. The 2004A server installation unconfigures any previous server, effectively
replacing the Windows service with a Windows application. This is necessary, because two
servers cannot run and listen to the same network port simultaneously.
If you install the 2004A server without first running the 2003C server uninstall, the
iprocsvr shortcut may not be in the system program startup group.There will be no IO
icon in the system tray and any attempt to perform instrument IO will fail.
To prevent this, run setup.exe from the /CM_Server directory of disk 2 in the 2003C
media kit and select the option to uninstall.
Alternatively, you could create a shortcut to the iprocsvr.exe program in the system
program startup group.

 

 Solution: enable process listing.

In ADS 2003C, the CM server process ( MsmtSrvr.exe ) would try to start the IO Libraries'
IO Control application ( iprocsvr.exe - the program responsible for putting the blue IO icon
in the icon tray) if that application was not already running.
To know whether it is necessary to start the IO Control application, the CM Server
program would list the processes currently running on the server PC. Some Windows
installations disable the ability to perform this process listing, so the CM Server could not
run.
This results in the CM client not connecting, even after having changed the Windows
service to run under an account other than LocalSystem. Also, the Diagnostics application
would not create an output file.
To verify that the problem is related to the server PC having disabled the ability to list
processes, follow these steps.

In Windows, click Start > Settings > Control Panel.1.
From the Control Panel dialog, click Administrative Tools > Event Viewer.2.
Scroll down to find error entries titled AgilentConnectionManager.3.
Right-click on the error entry and select Properties.4.
In the Description field, observe the following description.5.

Event Type: Error

Event Source: AgilentConnectionManager

Event Category: None

Event ID: 4

Date:  6/15/2004

Time:  12:24:54 PM

User:  N/A

Computer: SANC040320844

Description:

The following information is part of the event:
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Caught exception: System. InvalidOperationException:

Process performance counter is disabled,

so the requested operation cannot be performed.

at System.Diagnostics.NtProcessManager.

  GetProcessInfos\(PerformanceCounterLib library\)

at System.Diagnostics.NtProcessManager.GetProcessInfos

  \(String machineName, Boolean isRemoteMachine\)

at System.Diagnostics.ProcessManager.GetProcessInfos

  \(String machineName\)

at System.Diagnostics.Process.GetProcessesByName

  \(String processName, String machineName\)

at System.Diagnostics.Process.GetProcessesByName

  \(String processName\)

at Agilent.MeasurementServer.MsmtSrvr.StartSiclDaemons

  \(Boolean& weStartedSicl, Process& iproc\)

at Agilent.MeasurementServer.MsmtSrvr.

  Main\(String\[\] args\).

This verifies that the process performance counter has been disable, in turn disabling
Connection Manager.

To enable the process performance counter (and thereby Connection Manager), from an
account with Administrator privileges, complete the following steps.

Open a command prompt and cd to the ADS installation's bin directory, for example,1.
cd c:\ads2003c\bin
Stop the CM service by executing the command MsmtSrvc -stop .2.
Open the Registry Editor by entering regedit .3.
Open the registry key HKEY_LOCAL_MACHINE\SYSTEM\4.
CurrentControlSet\Services\PerfProc\Performance.
If that registry key contains a value named Disable Performance Counters, set its5.
value to 0 , as shown below.
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Restart the CM Service by executing the command MsmtSrvc -start.
6.

 

 No Instrument Access when Using Agilent 89600 Software

 

 Solution: unconfigure the instrument using the Agilent 89600 Select Hardware dialog.

Agilent 89600 software claims total ownership of instruments for the length of time those
instruments are configured.
If Connection Manager generates and error when trying to communicate with an
instrument that has been used with the Agilent 89600 software, unconfigure the
instrument using the Agilent 89600 Select Hardware dialog.
To unconfigure the instruments, follow these steps.

Open the 89600 software.1.
From the Main dialog, choose Utilities > Hardware.2.
Using the instrument tabs, uncheck instruments you want to use with Connection3.
Manager.

  

 Instrument Interface and Communication
This section list common instrument interface and communication problems and their
possible solutions.
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 The Server Hangs During Measurements or Remote Instrument
Explorer is not Responding

 

 Solution: observe the instrument display, correct any error state, and clear any instrument errors.

Many older instruments may generate error messages and shut down their IO when they
encounter an invalid state setting or command. This will disrupt instrument
communication until the error state has been corrected and the error message has been
cleared from the queue. Correct any invalid settings, ensure the instrument is receiving
the correct commands, clear the error queue, and repeat the measurement.

 

 Solution: connect and power on all instruments listed in the IO configuration.

If you have configured a LAN-connected instrument, but the instrument is not connected
or not powered on, the IO Libraries will try to open every listed device. Since the default
time out value for opening a LAN instrument is 2 minutes, any absent LAN-connected
instrument could cause the IO Libraries to take a long time to open an instrument session.
If an instrument listed in the server workstation IO configuration is not accessible (i.e.,
disconnected or turned off), the client's Remote Instrument Explorer will become
unresponsive.

 

 To run the IO Config setup

To check for an unresponsive instrument, follow these steps.

In the server's Windows system tray, select IO > Run IO Config.1.
In the IO Config dialog, highlight the TCPIP lan entry in the Configured Interfaces2.
group box and select Edit.
In the LAN Client dialog, select Edit VISA Config.3.
The TCPIP dialog lists which instruments are connected to the server through the4.
LAN.
Ensure that the instruments are connected and functioning properly.5.
If an instrument is not functioning, you must either return it to a functional state or6.
remove it from the IO config and restart the Connection Manager service.

 

 Run VISA Assistant to Verify Communication Link

To verify the server recognized your GPIB instrument, follow these steps.

In the server's Windows system tray, select IO > Run VISA Assistant.1.
Observe your instrument displayed in the VISA Assistant display panel.2.
Close VISA Assistant.3.
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 Communication Problems with Older Instruments

 

 Solution: send commands through the LAN server to slow the rate.

 Late model computers can send instructions faster than many vintage instruments can
process them. This situation often manifests itself when the instrument returns a message
that is not consistent with the measurement being made.
It is possible to slow down communications with an older instrument by running the
interface through the IO Libraries LAN server, causing the instructions to be sent to the
instrument at a slightly slower rate.
To send commands through the IO server, complete the following steps.

Run siclland.exe , located in the IO Libraries installation bin directory (i.e., \ Program1.
Files \ Agilent \ IO Libraries \ bin ) on the server workstation.

Run IO Config and add a VISA LAN client entry.2.
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Select Configure and specify the IP address of the server workstation (i.e., the3.
workstation running IO Config ).

When you use the Connection Manager client to specify an instrument, select the4.
instruments shown on the LAN interface ( GPIB1 in the preceding example).

 

 Solution: Extend the length of the GPIB cabling between the server and the instrument.
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 Extending the length of GPIB cable between the server and the instrument can decrease the speed
at which the instrument receives data from the server.

  

 Connection Manager Server Diagnostics
 
The Connection Manager client and server dialogs include server diagnostics. The
Connection Manager Server Diagnostics and Diagnostics Display dialogs collect and display
server configuration information for use in troubleshooting instrument communication
problems.

Note
At no time does the server implementation of this capability interact directly with instruments. Doing so
could interrupt a measurement in progress.

As shown, the client dialog contains a Server entry field, an information display area, as
well as OK , Refresh , Save to file... , and Help buttons. The server dialog contains a an
information display area, as well as OK and Save... buttons.
The Server field displays the name of the currently configured server.
The display area will contain the information gathered by the diagnostics routine. For
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individual explanations, see Understanding the Server Diagnostics Output.

Choose OK to dismiss the dialog.
Choose Refresh to refresh the diagnostic information after making changes to your server
configuration.
Choose Save to file... or Save... to open a Save File dialog where you can save the
diagnostic dialog contents in a text file. E-mail this text file to Agilent EEsof support staff
to provide them with the information to diagnose an instrument IO problem.

 

 To Diagnose the Server From the Server Window

From the Connection Manager Server main window, choose Diagnostics > Run1.
Diagnostics.
Observe the information in the display area.2.
Make necessary corrections to the server configuration.3.
Close the server.4.
Reopen the server.5.
Choose Diagnostics > Run Diagnostics.6.
Observe the information in the display area.7.
To save the diagnostics information, click Save to file... and enter a file name and8.
directory path.
To exit diagnostics, click OK.9.

 

 To Diagnose the Server From the Client Window

From the Connection Manager Client main window, choose Help > Diagnostics.1.
Choose server using the Set Server dialog and click OK.2.
Observe the information in the display area.3.
Make necessary corrections to the server configuration.4.
Click Refresh to run the diagnostics again.5.
To save the diagnostics information, click Save to file... and enter a file name and6.
directory path.
To exit diagnostics, click OK.7.

 

 Understanding the Server Diagnostics Output

This section describes the individual server diagnostics output items, from top to bottom
of the display.

 

 The CM Service Information

This section contains server version, server installation path, and the operating state of
the server, as shown:
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CM Service version info: 3.0.2004.1, Installation path:

  C:\Program Files\Agilent\Connection Manager

Server\MsmtSrvc.exe, Service state: The service is running.

Server version 2.0.2003.3 is ADS 2003C, server version 3.0.2004.1 is ADS 2004A, server
version 4.0.2005.1 is ADS 2005A, ADS 2006A is 5.0.2006.1.
The installation path is read from the registry key HKEY_LOCAL_MACHINE\
SYSTEM\CurrentControlSet\Services\AgilentConnectionManager\ImagePath. The
installation package creates this registry key when you install the Connection Manager
server.
The diagnostic routine queries the Service Control Manager to obtain the service state to
determine whether you are running the CM server as an application or a Windows service.
In server versions prior to version 3.0.2004.1, the CM server functioned as a Windows
service. Versions 3.0.2004.1 and later function as a Windows application. The 2004A CM
server installation, by default, will stop a previous instance of the Windows service,
remove the service from the system, then configure the Windows application to take its
place.
If preferred, you can override this new default and continue to use the Windows service.
Even though the Windows service is not configured into the system, it is still installed with
ADS 2004A.
If the service is not running, the following message appears on the display:

CM Service version info: 3.0.2004.1, Installation path:

  C:\Program Files\Agilent\Connection Manager

Server\MsmtSrvc.exe

Could not get service status.  System error recorded:

  The service has not been started.

If the service isn't installed, the following message appears on the display:

Could not read service registry key.  System error

recorded:

 

 IO Libraries Information

This section records the IO Libraries registry information. This is a complete description of
all IO configuration settings. This section contains IO libraries installation path, version,
and configured interfaces, as shown (important entries are highlighted):

IO Libraries set up correctly

IO Libraries version: M.01.01.04, Installation directory:

  C:\Program Files\Agilent\IO Libraries

Agilent Visa is primary: True

IO Libraries registry information...

   Registry key: CurrentVersion

       Registry name: Platform, Registry value: -1

       Registry name: PlatformName, Registry value: unknown

       Registry name: BaseDir, Registry value:
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          C:\Program Files\Agilent\IO Libraries

       Registry name: CurrentVersion, Registry value:

          M.01.01.04

       Registry name: CurrentVersionNumber, Registry value:

          1291911428

       Registry name: ProductCode, Registry value:

        \{04107B50-CCF1-11D3-931C-00108301D203\}

       Registry name: InstallLevel, Registry value: 256

       Registry name: 1394VersionCheck, Registry value:

          5.0.2195.2096

       Registry name: IOLibrariesVisaPresent, Registry value: 1

       Registry name: IOCFGRebootVal, Registry value: 0

       Registry name: IOControlHidden, Registry value: 0

       Registry key: Aliases

           Registry name: Serial, Registry value: ag232i

           Registry name: ag82341, Registry value: ag341i

           Registry name: hp82341, Registry value: ag341i

           Registry name: hp82340, Registry value: ag341i

           Registry name: e2071a, Registry value: ag341i

           Registry name: 82340, Registry value: ag341i

           Registry name: 82341, Registry value: ag341i

           Registry name: ag82350, Registry value: ag350i

           Registry name: hp82350, Registry value: ag350i

           Registry name: 82350, Registry value: ag350i

           Registry name: e2078a, Registry value: ag350i

           Registry name: hpe8491, Registry value: ag491i

           Registry name: age8491, Registry value: ag491i

           Registry name: e8491, Registry value: ag491i

           Registry name: hpilan, Registry value: agtlan

           Registry name: hptcpi, Registry value: agtlan

           Registry name: agilan, Registry value: agtlan

           Registry name: agtcpi, Registry value: agtlan

           Registry name: usb488, Registry value: agUsb488

           Registry name: 82357, Registry value: ag357i

       Registry key: INTF1

           Registry name: Name, Registry value: gpib0

           Registry name: VISAName, Registry value: GPIB0

           Registry name: VISAIntfType, Registry value: GPIB

           Registry name: VISAAutoConfigDriver,

              Registry value: AUTOCF

           Registry name: VISAAutoConfig, Registry value:

              System.Byte[ ]

           Registry name: LU, Registry value: 8

           Registry name: Interface, Registry value: 82357

           Registry name: BusAddr, Registry value: 21

           Registry name: SysCtl, Registry value: 1

           Registry name: Slot, Registry value: 0

           Registry name: TimeoutFloorMsec,

              Registry value: 2000

           Registry name: TimeoutUsbFlushMsec,

              Registry value: 2000

           Registry name: TimeoutWrCompleteFlushMsec,

              Registry value: 15000

           Registry name: IOBufferSizeKb,

              Registry value: 64

           Registry name: PNPvid, Registry value:

              0x00000957

           Registry name: PNPmodel, Registry value:

              0x00000107

           Registry name: PNPsn, Registry value:

              US42251605
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           Registry name: EnableExport, Registry value:

              System.Byte[ ]

           Registry key: VISADev

           Registry key: VISAIntfRsrc

               Registry key: GPIB0::INTFC

                   Registry name: Driver,

                      Registry value: INSTR

                   Registry name: Prefix,

                   Registry value: INTFC

       Registry key: INTF3

           Registry name: Name, Registry value: lan

           Registry name: LU, Registry value: 30

           Registry name: Interface,

              Registry value: agtlan

           Registry name: VISAName,

              Registry value: TCPIP0

           Registry name: VISAIntfType,

              Registry value: TCPIP

           Registry name: VISAAutoConfigDriver,

              Registry value: AUTOCF

           Registry name: VISAAutoConfig,

              Registry value: System.Byte[ ]

           Registry name: log_errors,

              Registry value: 1

           Registry name: lan_delta,

              Registry value: 25

           Registry name: sicl_infinity,

              Registry value: 120

           Registry name: lanProtocol,

              Registry value: 1

           Registry name: Slot,

              Registry value: 0

           Registry name: BusAddr,

              Registry value: 0

           Registry name: sigio,

              Registry value: 0

           Registry name: EnableExport,

              Registry value: System.Byte[ ]

           Registry key: VISADev

               Registry key:

                  TCPIP0::123.456.789.101::inst0

                   Registry key:

                      TCPIP0::123.456.789.101::inst0::INSTR

                       Registry name: Driver,

                          Registry value: INSTR

                       Registry name: Prefix,

                          Registry value: INSTR

           Registry key: VISAIntfRsrc

       Registry key: INTF4

           Registry name: Name, Registry value: usb0

           Registry name: VISAName,

              Registry value: USB0

           Registry name: VISAIntfType,

              Registry value: USB

           Registry name: VISAAutoConfigDriver,

              Registry value: AUTOCF

           Registry name: VISAAutoConfig,

              Registry value: System.Byte[ ]

           Registry name: LU, Registry value: 20

           Registry name: Interface,

              Registry value: usb488
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           Registry name: EnableExport,

              Registry value: System.Byte[ ]

           Registry key: Usb488Devices

           Registry key: VISADev

           Registry key: VISAIntfRsrc

       Registry key: PARAMS

           Registry name: ag232i,

              Registry value: LU,Name,Interface,NotUsed,

              PortNumber,SRQ,HWFlowControl

           Registry name: ag341i,

              Registry value: LU,Name,Interface,Slot,

              BusAddr,Switches,SysCtl,IRQ,

              PNPvid,PNPsn

           Registry name: ag350i,

              Registry value: LU,Name,Interface,Slot,

              BusAddr,PNPvid,PNPModel, PNPsecId,PNPsn,

              SysCtl,PNPprefix

           Registry name: ag491i, Registry value:

              LU,Name,Interface,NotUsed,NotUsed,

              CageIdHi,CageIdLo, RsrcMngrDelay,VmeBto,

              VmeBusReqLvl,ExtClockEnable,

              ExtTrigOutPolarity,ExtTrigInLevel,

              ExtTrigInPolarity,

              UseAllExtendedMem

           Registry name: agtlan,

              Registry value: LU,Name,Interface,Slot,

                 BusAddr,sicl_infinity,lan_delta,

                 sigio,log_errors,reserved,lanProtocol

           Registry name: aglansvr,

              Registry value: LU,Name,Interface,Slot,

                 BusAddr,sicl_infinity,log_errors,

                 log_locks_conns,keepalives

           Registry name: agUsb488,

              Registry value: LU,Name,Interface,Slot,

                 BusAddr

           Registry name: ag357i,

              Registry value: LU,Name,Interface,Slot,

                 BusAddr,PNPvid,PNPmodel,PNPsn

       Registry key: VISAInfo

Registry name: , Registry value: Comment: General Information on Agilent's VISA

Implementation

           Registry name: Spec Version, Registry value: 3145728

           Registry name: Manufacturer, Registry value: Agilent Technologies

Registry name: Copyright, Registry value: Copyright Agilent Technologies, 2003.

           Registry name: ManfVersion, Registry value: M.01.01.04

           Registry name: LastMod, Registry value: Fri Apr 30 10:34:17 2004

           Registry name: ModTool, Registry value: Agilent VISA Configuration Tool

           Registry name: ManfVersionNbr, Registry value: 1291911428

           Registry name: ManfID, Registry value: 4095

           Registry name: Logging, Registry value: OFF

           Registry name: MaxSessNbr, Registry value: 256

           Registry name: MaxNbrOfProcs, Registry value: 64

           Registry name: DefaultQSize, Registry value: 50

           Registry name: SleepMs, Registry value: 0

           Registry name: DefaultLockWait, Registry value: 0

           Registry name: DefaultAllowLocalSpaceFifo,

             Registry value: 0

           Registry key: DefaultIntfRsrcs

               Registry name: , Registry value: Interface

                  Resources to load during configuration ADD

                  functions
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               Registry key: BACKPLANE

                   Registry name: DrvrName, Registry value: INSTR

                   Registry name: PrefixName, Registry value: BACKPLANE

                   Registry name: GPIB, Registry value: System.Byte[ ]

                   Registry name: VXI, Registry value: System.Byte[ ]

                   Registry name: GPIB-VXI, Registry value: System.Byte[ ]

                   Registry name: ASRL, Registry value: System.Byte[ ]

                   Registry name: TCPIP, Registry value: System.Byte[ ]

                   Registry name: USB, Registry value: System.Byte[ ]

               Registry key: INTFC

                   Registry name: DrvrName, Registry value: INSTR

                   Registry name: PrefixName, Registry value: INTFC

                   Registry name: GPIB, Registry value: System.Byte[ ]

                   Registry name: VXI, Registry value: System.Byte[ ]

                   Registry name: GPIB-VXI, Registry value: System.Byte[ ]

                   Registry name: ASRL, Registry value: System.Byte[ ]

                   Registry name: TCPIP, Registry value: System.Byte[ ]

                   Registry name: USB, Registry value: System.Byte[ ]

               Registry key: MEMACC

                   Registry name: DrvrName, Registry value: INSTR

                   Registry name: PrefixName, Registry value: MEMACC

                   Registry name: GPIB, Registry value: System.Byte[ ]

                   Registry name: VXI, Registry value: System.Byte[ ]

                   Registry name: GPIB-VXI, Registry value: System.Byte[ ]

                   Registry name: ASRL, Registry value: System.Byte[ ]

                   Registry name: TCPIP, Registry value: System.Byte[ ]

                   Registry name: USB, Registry value: System.Byte[ ]

           Registry key: DefaultRsrcs

               Registry name: , Registry value: Resources to load

                  during auto-connect and configuration

                  ADD functions

               Registry key: INSTR

                   Registry name: DrvrName, Registry value: INSTR

                   Registry name: PrefixName, Registry value: INSTR

                   Registry name: GPIB, Registry value: System.Byte[ ]

                   Registry name: VXI, Registry value: System.Byte[ ]

                   Registry name: GPIB-VXI, Registry value: System.Byte[ ]

                   Registry name: ASRL, Registry value: System.Byte[ ]

                   Registry name: TCPIP, Registry value: System.Byte[ ]

                   Registry name: USB, Registry value: System.Byte[ ]

               Registry key: SOCKET

                   Registry name: DrvrName, Registry value: INSTR

                   Registry name: PrefixName, Registry value: SOCKET

                   Registry name: GPIB, Registry value: System.Byte[ ]

                   Registry name: VXI, Registry value: System.Byte[ ]

                   Registry name: GPIB-VXI, Registry value: System.Byte[ ]

                   Registry name: ASRL, Registry value: System.Byte[ ]

                   Registry name: TCPIP, Registry value: System.Byte[ ]

                   Registry name: USB, Registry value: System.Byte[ ]

The diagnostics routine reads this information out of the registry key
HKEY_LOCAL_MACHINE\SOFTWARE\Agilent\IO Libraries\CurrentVersion.
Agilent IO Libraries version M.01.01.04 is included with ADS 2004A and ADS 2003C.
To return the configured interfaces information, the routine dynamically loads the
visa32.dll library and queries the interface. To return the local interfaces information, the
routine loads the sicl32.dll library and queries the logical unit information.
For Plug and Play drivers to work correctly, VISA must be installed and the Agilent VISA
library has to be configured as Primary.
With regards to the entry Registry key: TCPIP0::123.456.789.101::inst0, when you add a
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device to the IO Configuration using the Edit VISA Configuration dialogs, each device
entry is recorded in the registry.
If visa32.dll is not in the system path or has had its name changed IO Libraries not set up
correctly.
The most common reason for this error is that the IO libraries did not install visa32.dll into
a directory in the system path.
Another common reason for this error is that the IO libraries are not installed with Agilent
Visa as the primary Visa implementation.

System error recorded: The specified module could not be found.

IO Libraries version: M.01.01.04, Installation directory: C:\Program

Files\Agilent\IO Libraries

Agilent Visa is primary: False

   This system needs to remove the IO Libraries and re-install with Agilent

Visa as primary.

Could not generate interface information.

The most common cause for this error is that the IO libraries Visa installation is incorrect.

 

 Service Account Information

This section contains IO libraries installation path, version, and configured interfaces, as
shown (important entries are highlighted):

Service account as configured in the registry: LocalSystem

Running as Local System.  This is a potential problem, as running as Local System

on some systems causes instrument IO to fail

Privileges...

   SeTcbPrivilege, Act as part of the operating system

   SeCreateTokenPrivilege, Create a token object

   SeTakeOwnershipPrivilege, Take ownership of files or other objects

   SeCreatePagefilePrivilege, Create a pagefile

   SeLockMemoryPrivilege, Lock pages in memory

   SeAssignPrimaryTokenPrivilege, Replace a process level token

   SeIncreaseQuotaPrivilege, Increase quotas

   SeIncreaseBasePriorityPrivilege, Increase scheduling priority

   SeCreatePermanentPrivilege, Create permanent shared objects

   SeDebugPrivilege, Debug programs

   SeAuditPrivilege, Generate security audits

   SeSecurityPrivilege, Manage auditing and security log

   SeSystemEnvironmentPrivilege, Modify firmware environment values

   SeChangeNotifyPrivilege, Bypass traverse checking

   SeBackupPrivilege, Back up files and directories

   SeRestorePrivilege, Restore files and directories

   SeShutdownPrivilege, Shut down the system

   SeLoadDriverPrivilege, Load and unload device drivers

   SeProfileSingleProcessPrivilege, Profile single process

   SeSystemtimePrivilege, Change the system time

   SeUndockPrivilege, Remove computer from docking station

   SeManageVolumePrivilege, Perform volume maintenance tasks

   SeImpersonatePrivilege, Impersonate a client after authentication

   SeCreateGlobalPrivilege, Create global objects
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Running the server under the Local System account on certain systems prevents the
system from loading visa32.dll. If the IO is not functioning and all the IO libraries
information is correct, run the service under an account with Administrator privileges.

 

 Drive Types

As a security precaution, runtime versions of .NET will not allow running networked
applications from removable media. Attempting to run the CM server from a removable
drive will fail and issue a security exception.

Enumerating drive types...

   C:  Drive type: Fixed

   D:  Drive type: CdRom -- the server will not work when

       installed on this type of drive

   R:  Drive type: Remote -- the server will not work when

       installed on this type of drive

   S:  Drive type: Remote -- the server will not work when

       installed on this type of drive

 

 Processes

This section contains a list of running processes. Important entries are highlighted, as
shown:

Snapshot of running processes...

   MsmtSrvc, Process id: 1280

   DiagnosticServi, Process id: 744

   CMD, Process id: 2080

   mstask, Process id: 956

   CTFMON, Process id: 1704

   iprocsvr, Process id: 2024

   SMSS, Process id: 204

   TASKMGR, Process id: 2128

   ati2evxx, Process id: 628

   adcist, Process id: 1696

   IDA, Process id: 1588

   MsmtSrvr, Process id: 2056

   Directcd, Process id: 1692

   winvnc, Process id: 1048

   IDASched, Process id: 1740

   iproc82357, Process id: 936

   PageMill, Process id: 732

   LSASS, Process id: 292

   WinMgmt, Process id: 1040

   svchost, Process id: 504

   OSA, Process id: 1572

   CreateCD50, Process id: 1676

   mdm, Process id: 712

   SERVICES, Process id: 280

   nutsrv4, Process id: 916

   explorer, Process id: 1448

   WZQKPICK, Process id: 1768
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   VPTray, Process id: 1660

   ltmoh, Process id: 1552

   CMD, Process id: 1764

   NMSSvc, Process id: 800

   epsilon, Process id: 1292

   SynTPEnh, Process id: 1332

   realsched, Process id: 1652

   CMServerDiagnos, Process id: 1972

   SynTPLpr, Process id: 1436

   regsvc, Process id: 352

   DefWatch, Process id: 676

   Eudora, Process id: 1744

   SMTray, Process id: 1636

   ltmsg, Process id: 1528

   atiptaxx, Process id: 1420

   svchost, Process id: 456

   CSRSS, Process id: 232

   WINLOGON, Process id: 228

   CMD, Process id: 2160

   Crypserv, Process id: 660

   spoolsv, Process id: 552

   Rtvscan, Process id: 872

   iproc488, Process id: 2048

   PROMon, Process id: 1512

   EABSERVR, Process id: 1508

   CMD, Process id: 116

   System, Process id: 8

   prpcui, Process id: 1612

   bash, Process id: 752

   Idle, Process id: 0

For the IO libraries to work, the processes named iprocsvr , iproc488 , and iproc82357
must be running. In 2003C, if these processes are not running, the CM server will start
them. Prior to that, the processes started when somebody interactively logged into the
server PC. If IO isn't working, one potential problem in 2003A is that no user is logged
onto the server PC.

 

 Directory Contents

This section contains a list of the server installation directory contents and revision
information for each file. The measurement DLLs are in the ImportedAssemblies directory.
The CM server revision for 2004A is 3.0.2004.1.

Directory contents...

   C:\Program Files\Agilent\Connection Manager Server\

      Agilent.TMFramework.dll, Version: 1.0.4230.0

   C:\Program Files\Agilent\Connection Manager

      Server\Agilent.TMFramework.InstrumentDriverInterop.dll,

      Version: 1.0.4230.0

   C:\Program Files\Agilent\Connection Manager

      Server\Agilent.TMFramework.InstrumentIO.Configuration.dll,

      Version: 1.0.4230.0

   C:\Program Files\Agilent\Connection Manager Server\

      Agilent.TMFramework.InstrumentIO.dll, Version:

      1.0.4230.0
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   C:\Program Files\Agilent\Connection Manager

      Server\Agilent.TMFramework.InstrumentIO.VisaInterop.dll,

      Version: 1.0.4230.0

   C:\Program Files\Agilent\Connection Manager Server\

      Agilent.TMFramework.InternalUtils.dll, Version:

      1.0.4230.0

   C:\Program Files\Agilent\Connection Manager Server\

      CMDiagnostics.dll, Version: 3.0.2004.1

   C:\Program Files\Agilent\Connection Manager Server\

CMServerDiagnostics.dll, Version: 3.0.2004.1

   C:\Program Files\Agilent\Connection Manager Server\

HwCatalog.dll, Version: 0.0.0.0

   C:\Program Files\Agilent\Connection Manager Server\

IsAdmin.dll, Version: 3.0.2004.1

   C:\Program Files\Agilent\Connection Manager Server\

LibMgr.dll, Version: 3.0.2004.1

   C:\Program Files\Agilent\Connection Manager Server\

MsmtEvents.dll, Version: 0.1.0.0

   C:\Program Files\Agilent\Connection Manager Server\

PowerManagement.dll, Version: 3.0.2004.1

   C:\Program Files\Agilent\Connection Manager Server\

VisaIO.dll, Version: 3.0.2004.1

   C:\Program Files\Agilent\Connection Manager Server\

vsassert.dll, Version: 7.0.9466.0

   C:\Program Files\Agilent\Connection Manager Server\

CMController.exe, Version: 3.0.2004.1

   C:\Program Files\Agilent\Connection Manager Server\

MsmtSrvc.exe, Version: 3.0.2004.1

   C:\Program Files\Agilent\Connection Manager Server\

MsmtSrvr.exe, Version: 3.0.2004.1

   C:\Program Files\Agilent\Connection Manager Server\

VisaInstFinder.exe, Version: 3.0.2004.1

   C:\Program Files\Agilent\Connection Manager

Server\ImportedAssemblies\AGE444XAVxipnpNETWrapper.dll,

Version: 1.0.0.0

   C:\Program Files\Agilent\Connection Manager Server\

ImportedAssemblies\Agilent8753.dll, Version:

0.0.0.0

   C:\Program Files\Agilent\Connection Manager Server\

ImportedAssemblies\ESGBServer.dll, Version:

3.0.2004.1

   C:\Program Files\Agilent\Connection Manager Server\

ImportedAssemblies\ESGCServer.dll, Version:

3.0.2004.1

   C:\Program Files\Agilent\Connection Manager

Server\ImportedAssemblies\HP856XEVxipnpNETWrapper.dll,

Version: 1.0.0.0

   C:\Program Files\Agilent\Connection Manager

Server\ImportedAssemblies\HP859XEVxipnpNETWrapper.dll,

Version: 1.0.0.0

   C:\Program Files\Agilent\Connection Manager Server\

ImportedAssemblies\HP871XVxipnpNETWrapper.dll,

Version: 1.0.0.0

   C:\Program Files\Agilent\Connection Manager

Server\ImportedAssemblies\HPE4406VxipnpNETWrapper.dll,

Version: 1.0.0.0

   C:\Program Files\Agilent\Connection Manager Server\

ImportedAssemblies\HPESGVxipnpNETWrapper.dll,

Version: 1.0.0.0

   C:\Program Files\Agilent\Connection Manager Server\

ImportedAssemblies\ScopeServer.dll, Version:
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3.0.2004.1

   C:\Program Files\Agilent\Connection Manager Server\

ImportedAssemblies\SparmServer.dll, Version:

3.0.2004.1

   C:\Program Files\Agilent\Connection Manager Server\

ImportedAssemblies\SparmServerPNA.dll, Version:

3.0.2004.1

   C:\Program Files\Agilent\Connection Manager Server\

ImportedAssemblies\SpectrumServer.dll, Version:

3.0.2004.1

   C:\Program Files\Agilent\Connection Manager Server\

ImportedAssemblies\VSAServer.dll, Version:

3.0.2004.1

 

 Plug and Play Driver Information

This section contains a list of the VISA Plug and Play drivers and revision information for
each file. ADS measurements require the highlighted DLLs shown below.

Plug and Play driver installation directory: C:\Program Files\VISA\winnt.

   C:\Program Files\VISA\winnt\bin\

AG875XVxipnpNETWrapper.dll, Version: 1.0.0.0

   C:\Program Files\VISA\winnt\bin\

AGE444XAVxipnpNETWrapper.dll, Version: 1.0.0.0

   C:\Program Files\VISA\winnt\bin\

age444xa_32.dll, Version: 1.0.0.1

   C:\Program Files\VISA\winnt\bin\

hp548xx_32.dll

   C:\Program Files\VISA\winnt\bin\

hp856xe_32.dll, Version: 1.0.0.0

   C:\Program Files\VISA\winnt\bin\

hp859xe_32.dll, Version: 1.0.0.0

   C:\Program Files\VISA\winnt\bin\

hp871x_32.dll

   C:\Program Files\VISA\winnt\bin\

hpe4406_32.dll, Version: 1.0.0.1

   C:\Program Files\VISA\winnt\bin\

HPESGVxipnpNETWrapper.dll, Version: 1.0.0.0

   C:\Program Files\VISA\winnt\bin\

hpesg_32.dll, Version: 1.0.0.1

   C:\Program Files\VISA\winnt\bin\

hpgpvx32.dll, Version: 77.1.1.4

   C:\Program Files\VISA\winnt\bin\

ag875x_32.dll, Version: 1.0.0.1

 

 Module Information

This section contains a list of the modules loaded into the MsmtSrvr.exe process. This
information contains the versions of system and measurement libraries the server actually
has loaded in memory.

Module information for MsmtSrvr...
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Module name: MsmtSrvr.exe

File:             C:\Program Files\Agilent\

Connection Manager Server\MsmtSrvr.exe

InternalName:     MsmtSrvr.exe

OriginalFilename: MsmtSrvr.exe

FileVersion:      5.0.2006.1

FileDescription:  Agilent Connection Manager

Product:          Agilent Connection Manager

ProductVersion:   5.0.2006.1

Debug:            False

Patched:          False

PreRelease:       False

PrivateBuild:     False

SpecialBuild:     False

Language          Language Neutral

Module name: ntdll.dll

File:             C:\WINDOWS\system32\ntdll.dll

InternalName:     ntdll.dll

OriginalFilename: ntdll.dll

FileVersion:      5.1.2600.2180\(xpsp_sp2_rtm.040803-215\)

FileDescription:  NT Layer DLL

Product:          Microsoft Windows Operating System

ProductVersion:   5.1.2600.2180

Debug:            False

Patched:          False

PreRelease:       False

PrivateBuild:     False

SpecialBuild:     False

Language          English (United States)

 

 System Information

This section contains a description of the server PC memory, operating system, and
processor. Important entries are highlighted, as shown:

Memory information...

   Total Physical Memory: 527941632

   Free Physical Memory: 281899008

   Total Page File: 1289859072

   Free Page File: 1006911488

   Total Virtual Memory: 2147352576

   Free Virtual Memory: 1947172864

Operating system information...

   Microsoft Windows XP

   Uniprocessor Free

   Service Pack 1

Processor information...

   Registry key: 0

       Registry name: Component Information,

Registry value: System.Byte[ ]

       Registry name: Identifier, Registry value:

x86 Family 15 Model 2 Stepping 4

       Registry name: Configuration Data, Registry value:

       Registry name: ProcessorNameString, Registry value:      

Intel® Pentium® 4 Mobile CPU 1.70GHz

       Registry name: VendorIdentifier, Registry value:

GenuineIntel
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       Registry name: FeatureSet, Registry value: 12287

       Registry name: ~MHz, Registry value: 1694

       Registry name: Update Status, Registry value: 0

       Registry name: Update Signature, Registry value:

System.Byte[ ]

       Registry name: Previous Update Signature,

Registry value: System.Byte[ ]

New, higher-speed computers with fast HPIB interfaces can overload old, slower
instruments. By recording the processor clock speed and the IO Libraries information
above, EEsof support engineers can help diagnose these data overflow problems.

If the PC has more than one processor, there will be additional entries with headings like
Registry key: 1 and so on.
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